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安全上のご注意
ご使用の前に、必ずこの「安全上のご注意」をよくお読みください。

ここに示した注意事項は、製品を安全に正しくご使用いただき、お客様やほかの方々への危害や財産への
損害を未然に防止するためのものです。必ずお守りください。

■ 記号表示について
この製品や取扱説明書に表示されている記号には、次のような意味があります。

■「警告」と「注意」について
以下、誤った取り扱いをすると生じることが想定される内容を、危害や損害の大きさと切迫の程度を明示するために、
「警告」と「注意」に区分して掲載しています。

ヤマハ製電子楽器以外に使用しない。
電源アダプターは、ヤマハ製電子楽器専用です。他
の用途には、ご使用にならないでください。故障、
発熱、火災などの原因になります。

電源アダプターは、室内専用のため屋外およ
び水滴のかかる環境では、使用しない。また、
水の入った物、花瓶などを機器の上に置かな
い。
内部に水などの液体が入ると、感電や火災、または
故障の原因になります。

製品は電源コンセントの近くに設置する。
電源プラグに容易に手が届く位置に設置し、異常を
感じた場合にはすぐに製品の電源スイッチを切り、
電源プラグをコンセントから抜いてください。ま
た、電源スイッチを切った状態でも微電流が流れて
います。この製品を長時間使用しないときは、必ず
電源プラグをコンセントから抜いてください。

「ご注意ください」という注意喚起を示します。

～しないでくださいという「禁止」を示します。

「必ず実行」してくださいという強制を示します。

警告
この表示の欄は、「死亡す
る可能性または重傷を負
う可能性が想定される」
内容です。

注意
この表示の欄は、「傷害を
負う可能性または物的損
害が発生する可能性が想
定される」内容です。

電源アダプターについて

 警告

禁止

禁止

 注意

必ず実行
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 警告

電源コードをストーブなどの熱器具に近
づけたり、無理に曲げたり、傷つけたりし
ない。また、電源コードに重いものをのせ
ない。
電源コードが破損し、感電や火災の原因になります。

電源は必ず交流100Vを使用する。
エアコンの電源など交流 200V のものがあります。
誤って接続すると、感電や火災のおそれがあります。

電源アダプターは、必ず指定のもの(70
ページ)を使用する。
異なった電源アダプターを使用すると、故障、発熱、
火災などの原因になります。

電源プラグにほこりが付着している場合
は、ほこりをきれいに拭き取る。
感電やショートのおそれがあります。

この製品の内部を開けたり、内部の部品を
分解したり改造したりしない。
感電や火災、けが、または故障の原因になります。

本体の上に花瓶や薬品など液体の入った
ものを置かない。また、浴室や雨天時の屋
外など湿気の多いところで使用しない。
内部に水などの液体が入ると、感電や火災、または故
障の原因になります。入った場合は、すぐに電源ス
イッチを切り、電源プラグをコンセントから抜いた
上で、お買い上げの販売店または巻末のヤマハ修理
ご相談センターに点検をご依頼ください。

ぬれた手で電源プラグを抜き差ししない。
感電のおそれがあります。

本体の上にろうそくなど火気のあるもの
を置かない。
ろうそくなどが倒れたりして、火災の原因になりま
す。

下記のような異常が発生した場合、すぐに
電源スイッチを切り、電源プラグをコンセ
ントから抜く。
・電源コード/プラグがいたんだ場合
・製品から異常なにおいや煙が出た場合
・製品の内部に異物が入った場合
・使用中に音が出なくなった場合
そのまま使用を続けると、感電や火災、または故障の
おそれがあります。至急、お買い上げの販売店または
巻末のヤマハ修理ご相談センターに点検をご依頼く
ださい。

楽器本体について

電源 /電源アダプター

禁止

必ず実行

必ず実行

必ず実行

分解禁止

禁止

水に注意

禁止

禁止

火に注意

禁止

異常に気づいたら

必ず実行
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 注意

たこ足配線をしない。
音質が劣化したり、コンセント部が異常発熱して
火災の原因になることがあります。

電源プラグを抜くときは、電源コードを持
たずに、必ず電源プラグを持って引き抜
く。
電源コードが破損して、感電や火災の原因になるこ
とがあります。

長期間使用しないときや落雷のおそれが
あるときは、必ずコンセントから電源プラ
グを抜く。
感電や火災、故障の原因になることがあります。

不安定な場所に置かない。
本体が転倒して故障したり、お客様やほかの方々が
けがをしたりする原因になります。

この製品を持ち運びする場合は、必ず2人
以上で行なう。
この製品を 1 人で無理に持ち上げると、腰を痛めた
り、この製品が落下して破損したり、お客様やほかの
方々がけがをしたりする原因になります。

本体を移動するときは、必ず電源コードな
どの接続ケーブルをすべて外した上で行
なう。
コードをいためたり、お客様やほかの方々が転倒し
たりするおそれがあります。

この製品を電源コンセントの近くに設置
する。
電源プラグに容易に手が届く位置に設置し、異常を
感じた場合にはすぐに電源スイッチを切り、電源プ
ラグをコンセントから抜いてください。また、電源ス
イッチを切った状態でも微電流が流れています。こ
の製品を長時間使用しないときは、必ず電源プラグ
をコンセントから抜いてください。

すべての機器の電源を切った上で、ほかの
機器と接続する。また、電源を入れたり
切ったりする前に、機器のボリュームを最
小にする。
感電、聴力障害または機器の損傷の原因になります。

演奏を始める前に機器のボリュームを最
小にし、演奏しながら徐々にボリュームを
上げて、適切な音量にする。
聴力障害または機器の損傷の原因になります。

本体の上にのったり重いものをのせたり
しない。また、ボタンやスイッチ、入出力
端子などに無理な力を加えない。
本体が破損したり、お客様やほかの方々がけがをし
たりする原因になります。

大きな音量で長時間ヘッドフォンを使用
しない。
聴覚障害の原因になります。

使用後は、必ず電源を切りましょう。
[ ](スタンバイ/オン)スイッチを切った状態(画面表示が消え
ている)でも微電流が流れています。[ ](スタンバイ/オン)ス
イッチが切れているときの消費電力は、最小限の値で設計さ
れています。この製品を長時間使用しないときは必ず電源プ
ラグをコンセントから抜いてください。

電源 /電源アダプター

禁止

必ず実行

必ず実行

設置

禁止

必ず実行

必ず実行

必ず実行

●データが破損したり失われたりした場合の補
償はいたしかねますので、ご了承ください。

●不適切な使用や改造により故障した場合の保
証はいたしかねます。

接続

必ず実行

必ず実行

取り扱い

禁止

禁止
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ご使用上の注意
製品の故障、損傷や誤動作、データの損失を防ぐため、以下
の内容をお守りください。

■ 製品の取り扱い/お手入れに関する注意
• テレビやラジオ、ステレオ、携帯電話など他の電気製品の
近くで使用しないでください。楽器本体またはテレビやラ
ジオなどに雑音が生じる原因になります。iPad、iPhone、
iPod touchのアプリケーションと一緒に使用する場合は、
通信によるノイズを避けるためiPad、iPhone、iPod 
touchの機内モードをオンにしてお使いいただくことをお
すすめします。

• 直射日光のあたる場所(日中の車内など)やストーブの近くな
ど極端に温度が高くなるところ、逆に温度が極端に低いと
ころ、また、ほこりや振動の多いところで使用しないでく
ださい。本体のパネルが変形したり、内部の部品が故障し
たり、動作が不安定になったりする原因になります。

• 本体上にビニール製品やプラスチック製品、ゴム製品など
を置かないでください。本体のパネルや鍵盤が変色/ 変質す
る原因になります。

• 手入れするときは、乾いた柔らかい布、または水を含ませ
た柔らかい布を固くしぼってご使用ください。ベンジンや
シンナー、アルコール、洗剤、化学ぞうきんなどを使用す
ると、変色/変質する原因になりますので、使用しないでく
ださい。

■ データの保存に関する注意

● 編集したパフォーマンスデータ
本体にセーブせずに電源を切ると消えてしまいます。
オートパワーオフ機能(19ページ)により電源が切れた場合も同
様です。

● MIDI設定、システム設定
画面を切り替えたときにデータが保存されます。画面を切り替
えずに電源を切ったり、オートパワーオフにより電源が切れる
とデータが消えてしまうので、ご注意ください。

保存しておきたいデータは、本体またはUSBフラッシュメモ
リーに保存してください(60ページ)。
ただし、本体に保存したデータは故障や誤操作などのために失
われることがあります。大切なデータは、USBフラッシュメモ
リーに保存してください(60ページ)。USBフラッシュメモリー
の取り扱いについては、61ページをご覧ください。

お知らせ
● データの著作権に関するお願い
• ヤマハ(株)および第三者から販売もしくは提供されている音
楽/サウンドデータは、私的使用のための複製など著作権法
上問題にならない場合を除いて、権利者に無断で複製また
は転用することを禁じられています。ご使用時には、著作
権の専門家にご相談されるなどのご配慮をお願いします。

• この製品に内蔵または同梱されたコンテンツは、ヤマハ(株)
が著作権を有する、またはヤマハ(株)が第三者から使用許諾
を受けている著作物です。製品に内蔵または同梱されたコ
ンテンツそのものを取り出し、もしくは酷似した形態で記
録/録音して配布することについては、著作権法等に基づ
き、許されていません。

※上記コンテンツとは、コンピュータープログラム、伴奏
スタイルデータ、MIDIデータ、WAVEデータ、音声記録
データ、楽譜や楽譜データなどを含みます。

※上記コンテンツを使用して音楽制作や演奏を行ない、そ
れらを録音や配布することについては、ヤマハ(株)の許
諾は必要ありません。

● 製品に搭載されている機能/データに関するお知らせ
• この製品には、XGフォーマット以外の音楽/サウンドデー
タを扱う機能があります。その際、元のデータをこの楽器
に最適化して動作させるため、オリジナルデータ(音楽/サウ
ンドデータ)制作者の意図どおりには再生されない場合があ
ります。ご了承のうえ、ご使用ください。

● 取扱説明書の記載内容に関するお知らせ
• この取扱説明書に掲載されているイラストや画面は、すべ
て操作説明のためのものです。したがって、実際の仕様と
異なる場合があります。

• [ ]は、パネル上にあるボタン類や端子、LCD画面上のボタ
ンを示します。

• Windowsは、米国Microsoft Corporationの米国およびそ
の他の国における登録商標です。

• Apple、macOS、Mac、iPhone、iPad、iPod touch、
Logicは、米国および他の国々で登録されたApple Inc.の商
標です。

• AbletonはAbleton AGの商標です。

• IOSは、米国およびその他の国におけるCisco社の商標また
は登録商標であり、ライセンスに基づき使用されています。

• MIDIは社団法人音楽電子事業協会(AMEI)の登録商標です。

• その他、本書に記載されている会社名および商品名等は、
各社の登録商標または商標です。

ヤマハ製品では、機能や操作性向上のために、予告なく
ファームウェアをアップデートすることがあります。製品
の機能を十分に生かしてお楽しみいただくため、最新バー
ジョンにアップデートすることをおすすめします。最新の
ファームウェアは、下記ウェブサイトからダウンロードす
ることができます。
https://jp.yamaha.com/support/

この製品は、高調波電流規格 JIS C 61000-3-2 に適合
しています。

機種名 ( 品番 )、製造番号 ( シリアルナンバー )、電源条件などの情
報は、製品の底面にある銘板または銘板付近に表示されています。
製品を紛失した場合などでもご自身のものを特定していただけるよ
う、機種名と製造番号については以下の欄にご記入のうえ、大切に
保管していただくことをお勧めします。

機種名 

製造番号

(bottom_ja_02)

https://jp.yamaha.com/support/
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Sounds

Design

このたびは、ヤマハミュージックシンセサイザー MODX6/7/8 をお買い上げいただきまして、
まことにありがとうございます。MODX6/7/8 は、フラッグシップシンセサイザー MONTAGE
の生み出した新しい音表現を、より多くの人々に体験していただけるような楽器を目指しました。

MODXは、MONTAGEに搭載された新しい音源システム「Motion Control 
Synthesis Engine」を搭載しました。高品位な AWM2サウンドと、ダイナミック
な FM-Xサウンドを、多彩なコントローラーを使って連続的に変化させることが可能
です。
また、MONTAGEサウンドを使った音作りで、より積極的にリズムパートを楽しめ
るよう、リズムパターン機能を新たに搭載しました。「Motion Control」のリズミカ
ルな音変化を手軽に作り出せます。

サウンド

デザイン

MODX6/7/8を通じて、皆様の音楽活動がよりよいものになること
を心よりお祈りしています。

ヤマハMODX6/7/8 開発チーム一同

スーパーノブやタッチパネル搭載の大型カラーLCDなど、MONTAGEの表現力や視
認性はそのままに、軽量かつ持ち運びやすいデザインにしました。MONTAGE直系
の音表現を、あなたのライブ演奏へ持ち出すことができます。

開発チームからのメッセージ
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このたびは、ヤマハ製品をお買い上げいただき、誠にありがとうございます。
この楽器はライブ演奏や音楽制作にお使いいただけるシンセサイザーです。
この楽器に搭載された機能を十分に活かし、演奏をお楽しみいただくため、本書をよくお読みになってからご使用ください。
また、お読みになったあとも、いつでもご覧になれるところに大切に保管していただきますようお願いします。

取扱説明書について

取扱説明書(本書)
MODXの基本機能について説明しています。MODXの使い方全般を知りたい場合にご活用ください。さらに詳しい情報や操作
方法は、リファレンスマニュアルをご参照ください。

PDFマニュアル

● リファレンスマニュアル
MODXの内部構造、他機器との接続方法例について、詳細に説明しています。冊子の取扱説明書には掲載されていない、
より詳細な情報を知りたい場合は、このマニュアルをご活用ください。

● シンセサイザーパラメーターマニュアル
シンセサイザーでよく用いられるパラメーターやエフェクトタイプ/パラメーター、MIDIメッセージなどについて説明して
います。まずは取扱説明書およびリファレンスマニュアルをお読みいただき、パラメーターやエフェクトなどについてさら
に詳しく知りたい場合にこのマニュアルをご活用ください。

● データリスト
パフォーマンス、ウェーブフォーム、エフェクトタイプ、アルペジオタイプなどの本体内蔵コンテンツのリストや、MIDI
インプリメンテーションチャートなどの資料を掲載しています。

付属品について
• 電源アダプター
• 取扱説明書(本書)
• CUBASE AI DOWNLOAD INFORMATION (CUBASE AIダウンロードについて)
• 保証書

PDFマニュアルの活用方法
リファレンスマニュアル、シンセサイザーパラメーターマニュアル、データリストは、電子ファイル(PDF形式)になって
います。これらのPDFマニュアルは、ヤマハ ダウンロードのウェブサイトからご覧いただけます。インターネットに接
続して以下のウェブサイトを開き、「モデル名から検索」テキストボックスにモデル名「MODX」と入力して「検索」を
クリックします。

ヤマハ ダウンロード
https://jp.yamaha.com/support/

これらの電子ファイルは、コンピューターを使ってご覧いただくことができます。コンピューターでご覧いただくソフト
ウェアとして「Adobe® Reader®」を使うと、用語をすばやく検索したり、必要な部分のみ印刷したり、リンクをク
リックして該当する項目を開いたりすることができます。特に用語検索とリンク機能は、電子ファイルならではの便利な
機能です。ぜひご活用ください。

最新のAdobe Readerは下記のURLよりダウンロードできます。
http://www.adobe.com/jp/products/reader/

https://jp.yamaha.com/support/
http://www.adobe.com/jp/products/reader/
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特長

■ 多様な音楽ジャンルをカバーする、徹底強化さ
れたハイクオリティーな音色

定評のあるAWM2音源は、MONTAGEと同等の約5GB 
(16ビットリニア換算時)の波形を搭載しました。新しい大
容量波形を使用したピアノ音色はもちろん、すべてのカテゴ
リーにおいて音色のクオリティーを強化しています。
1.0GBのユーザーフラッシュメモリーが標準搭載になり、
さまざまな音色ライブラリーを本体に取り込めます。もちろ
ん取り込んだデータは電源をオフにしても消えることはない
ため、内蔵音色と同様に活用できます。また、新たにFM-X
音源を搭載しました。定番FMサウンドから新世代FMサウ
ンドまで、FM-X音源ならではの幅広い音変化を生かしたサ
ウンドを使って、AWM2音源だけではカバーしきれない音
表現が可能です。AWM2音源とFM-X音源を組み合せるこ
とで、音作りの可能性は無限に広がります。 

■ 多彩なエフェクトシステム
Spiralizer、Rotary Speaker 2、Uni Comp Down、Uni 
Comp Up、Parallel Comp、Presenceなど、新たなエ
フェクトを多数搭載しました。各パートに装備されたVCM 
(Virtual Circuitry Modeling)エフェクトやボコーダーなど
を含むさまざまなタイプを設定できるインサーションエフェ
クト(最大12 パート + A/D パート)、インサーションエ
フェクトの前後に装備された、3バンドと2バンドのデジタ
ルEQ (イコライザー )、マルチバンドコンプなどが設定でき
るマスターエフェクト、さらに5バンドのデジタルEQであ
るマスター EQなど、多彩なエフェクトシステムを搭載して
います。 

■ 新しい音表現を可能にするモーションコント
ロール機能

モーションコントロール機能は、モーション(リズミカルな
音変化と多次元音変化)を生み、その変化をリアルタイムに
コントロールする、まったく新しい音表現を実現した機能で
す。モーションコントロール機能は、演奏者のパッションに
呼応するようにサウンドをドラスティックに変化させ、ビー
トに合わせて表情豊かに演出します。さらに光の効果で高次
元なサウンドを創出します。モーションコントロール機能と
して、以下の3つを用意しています。 

1) スーパーノブ: 多次元音変化を生み出すコントローラー。
音やビートの変化を、光の変化と動きで表現します。

2) モーションシーケンサー : モーションをシーケンシャル
(連続的)に動作させます。

3) エンベロープフォロワー : モーションをオーディオ入力
のテンポに同期させます。 

■リズムパターン機能 
リズムパートを使った積極的な音作りのために、リズムパ
ターン機能を搭載しました。リズムパートを素早くアサイン
して、エンベロープフォロワーなどの機能を使って
「Motion Control」のリズミカルな音変化を手軽に作り出
せます。

■ 新しい音楽シーンを彩る豊富なアルペジオタイプ
とモーションシーケンス

新しい音楽シーンを彩るべく、10,000を超える豊富なア
ルペジオタイプを搭載しました。時間変化により音に躍動感
をあたえるモーションシーケンスと豊富なアルペジオタイプ
を組み合わせることで、より高い表現力を持つフレーズ演奏
が可能です。アルペジオタイプとモーションシーケンス、さ
らにパートボリュームなどの他のパラメーターとを組み合わ
せて、シーンとして8つ保存することができます。まさに曲
の展開に合わせた「シーン」を瞬時に呼び出せるようになり
ました。 

■ ライブパフォーマンスをアシストする機能 
ライブパフォーマンスで使用する音色を簡単に登録、呼び出
しができるライブセット機能を搭載しました。曲の進行順に
必要な音色を登録しておくことで、音色選択に迷うことなく
快適にライブパフォーマンスを行なえます。また、音色切り
替え時の音切れをなくすSSS (シームレス サウンド スイッ
チング *1)機能を搭載しました。発音中のエフェクトを完全
に保持したまま、次の音色にスムーズに切り替えます。 

*1 パフォーマンスあたり最大4パートまでの音色で効果可能 

■ より使いやすくなったユーザーインターフェース
モードレスによるシンプルな構成を実現するとともに、あつ
かいやすいタッチパネルを導入しました。演奏者は、直感的
に使えるタッチパネルと操作が確実でショートカット設定に
も適したスイッチを志向にあわせて使い分けることにより、
ストレスのない高効率なオペレーションが行なえます。また
面発光スイッチは状態によって光り方が3種類に変化しま
す。現在有効なスイッチが一目でわかるので、操作に迷わず
演奏に集中できます。 

■ 持ち運びに便利なコンパクトデザインと、本格的
な鍵盤を搭載

MODXは、持ち運びを考えてコンパクトなサイズと重量を
実現しました。鍵盤に関しても、MODX6は61鍵、
MODX7は76鍵のセミウェイテッド鍵盤、MODX8は88
鍵のGHS鍵盤を採用し、軽量ながらも、本格的な弾き心地
を実現しました。 

■ 快適なシステムコネクティビティー 
4ch In/10ch OutのUSBオーディオインターフェースを搭
載し、MODXの高品位サウンドを簡単かつ確実にMac/PC
に録音できます(サンプリング周波数は44.1kHz)。また、
iOSデバイスとの接続も対応しています。 
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フロントパネル

1 鍵盤
MODX6は61鍵、MODX7は76鍵、MODX8は88鍵で構成
されています。アコースティックピアノのように、弾き方の強
弱でパフォーマンスの音量や音色をコントロールできるイニ
シャルタッチがついています。

2 ピッチベンドホイール
ピッチベンド効果のアップ/ダウンをコントロールします。その
他、さまざまな機能を割り当てて使用できます。

3 モジュレーションホイール
モジュレーション効果をコントロールします。その他、さまざ
まな機能を割り当てて使用できます。

4 [MASTER VOLUME] (マスターボリューム)ノブ
(19ページ)

マスターボリュームを調節します。ノブを右へ回すほど、
OUTPUT [L/MONO]、[R]端子や[PHONES]端子からの出力
が大きくなります。

5 [USB VOLUME (MONITOR)] 
(USBボリューム(モニター ))ノブ

[USB TO HOST]端子からのオーディオ入力のうち、
OUTPUT [L/MONO]、[R]端子や[PHONES]端子へ直接出力
される音量を調節します。

6 A/D INPUT [GAIN] (A/Dインプットゲイン)ノブ
(50ページ)

A/D INPUT [L/MONO]、[R]端子からの入力信号のゲインを
調節します。右に回すほど、ゲインが大きくなります。

NOTE
A/D INPUT [L/MONO]、[R]端子に接続する機器の出力レベルに応じ
て、[UTILITY] → [Settings] → [Audio I/O] → [A/D Input]の設定を
変える必要があります。マイクなどの出力レベルの低い機器を接続した
場合は「Mic」(マイク)に、オーディオ機器や電子楽器などの出力レベル
の高い機器を接続した場合は「Line」(ライン)に設定します。

7 A/D INPUT [ON/OFF] 
(A/Dインプット オン/オフ)ボタン(50ページ)

A/D INPUT [L/MONO]、[R]端子からの入力を有効にするか
無効にするかを切り替えます。オンのときはボタンが点灯、
オフのときはボタンが消灯します。

8 [ASSIGN 1]、9 [ASSIGN 2] 
(アサイナブルスイッチ1、2)ボタン 

より多彩な表現を実現するために、リアルタイムにエレメント/
オペレーターを変化させるボタンとして機能します。また、さ
まざまな機能を割り当てて使用できます。オンのときはボタン
が点灯、オフのときはボタンが消灯します。

各部の名称と機能
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) [MOTION SEQ HOLD] 
(モーションシーケンサーホールド)ボタン

モーションシーケンサー再生時にこのボタンを押すとオンにな
り、モーションシーケンスの出力値が持続します。オンのとき
はボタンが点灯、オフのときはボタンが消灯します。

! [MOTION SEQ TRIGGER] 
(モーションシーケンサートリガー )ボタン

モーションシーケンサーのトリガーレシーブパラメーターをオ
ンにしておくと、このボタンを押すことでモーションシーケン
スが再生されます。オンのときはボタンが点灯、オフのときは
ボタンが消灯します。

@ [ARP ON/OFF] (アルペジオ オン/オフ)ボタン
アルペジオを再生させるかどうか、このボタンをオン/オフする
ことにより設定できます。各パートでアルペジオスイッチがオ
フに設定されている場合、このボタンをオンにしても、その
パートでアルペジオは再生されません。オンのときはボタンが
点灯、オフのときはボタンが消灯します。

# [MS ON/OFF] 
(モーションシーケンサー オン/オフ)ボタン

モーションシーケンサーを有効にするかどうか、このボタンを
オン/オフすることにより設定できます。各パートおよび各レー
ンでモーションシーケンサースイッチがオフに設定されている
場合、このボタンをオンにしても、そのパートでモーション
シーケンスは再生されません。オンのときはボタンが点灯、
オフのときはボタンが消灯します。

$ OCTAVE (オクターブ) [－]/[＋]ボタン
これらのボタンを押すたびに、鍵盤を1オクターブずつダウン/
アップさせることができます。
また、[SHIFT]ボタンを押したままこれらのボタンを押すと、
トランスポーズ[－]/[＋]ボタンとして機能します。ボタンを押
すたびに、鍵盤を1半音ずつダウン/アップさせることができま
す。2つのボタンを同時に押すと標準の音の高さ(0)に戻りま
す。
変更しているオクターブによって、ボタンの点灯状態が変わり
ます。
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イラストは代表してMODX8を掲載しています。
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% ノブファンクション 
[TONE]/[EG/FX]/[EQ]/[ARP/MS]ボタン

ノブの機能を切り替えます。ランプが点灯している段の機能が
選択されます。
ノブの機能は、パフォーマンスコントロール状態(30ページ)で
は全パート共通に働き、パートコントロール状態(30ページ)で
は選択したパートに対して働きます。
選択されている機能のランプは点灯、選択されていない機能の
ランプは消灯します。

^ [ASSIGN] (アサイン)ボタン
ノブをAssign 1～4として使うか、5～8として使うかを切り
替えます。
割り当てられた機能は、パフォーマンスコントロール状態(30
ページ)では全パート共通に働き、パートコントロール状態(30
ページ)では選択したパートに対して働きます。
Assign 1～4のときはボタンが点灯、Assign 5～8のときは
ボタンが点滅します。

& ノブ1～4 (5～8)
パネルの4つのノブを回すことで、演奏中のパートの音色やア
ルペジオ再生、モーションシーケンサーに関する設定など、さ
まざまなパラメーターを調節できます。左上にあるノブファン
クション[TONE]/[EG/FX]/[EQ]/[ARP/MS]ボタン、
[ASSIGN]ボタンを押すことにより、ノブの機能を切り替えま
す。[ASSIGN]ボタンが点灯または点滅のときは、アサイナブ
ルノブとして機能します。

* スライダーファンクション[PART](パート)/
[ELEMENT/OPERATOR]
(エレメント/オペレーター )ボタン

パネルの4つのコントロールスライダーをパートの操作に使う
かエレメントの操作に使うかを選びます。ボタンを押すたびに
「PART」と「ELEMENT/OPERATOR」が切り替わります。
選択されているほうのランプが点灯します。

( スライダーセレクト[1-4]/[5-8]ボタン
パネルの4つのコントロールスライダーをパートまたはエレメ
ントの[1]～[4]として使うか、パートまたはエレメントの[5]～
[8]として使うかを選びます。ボタンを押すたびに[1-4]と[5-8]
が切り替わります。[1-4]または[5-8]の場合は、選択されてい
るほうのランプが点灯します。
[SHIFT]ボタンを押したままスライダーセレクト[1-4]/[5-8]ボ
タンを押すと、[9]～[12]または[13]～[16]へと切り替わりま
す。[9]～[12]または[13]～[16]の場合は、選択されているほ
うのランプが点滅します。

A コントロールスライダー1～4 
(5～8/9～12/13～16）

16個のパート(1～4/5～8/9～12/13～16)のボリュームや
ノーマルパート(AWM2)を構成する8つのエレメントもしくは
ノーマルパート(FM-X)のオペレーター、ドラムパートのキーの
ボリュームを、それぞれ調整します。

NOTE 
• コントロールスライダーがすべて0になっている場合(すべて下がり
きっている場合)、本体の音が鳴らない可能性があります。鍵盤を弾い
ても音が鳴らない場合、ソングを再生させても音が鳴らない場合など
は、コントロールスライダーの位置を上げてみてください。

• [MASTER VOLUME]ノブでは、本体から出力されるオーディオ音声
のボリュームを調節します。それに対して、コントロールスライダー
ではパートのエレメント/キー /オペレーターやパフォーマンスの各
パートのボリュームを、パラメーターの設定値として変更することに
なります。したがって変更された値は、パフォーマンスデータとして
保存(ストア)できます。

B シーンセレクト[1-4]/[5-8]ボタン
パネルの4つのSCENEボタンをシーン[1]～[4]ボタンとして使
うか、シーン[5]～[8]ボタンとして使うかを選びます。ボタン
を押すたびに[1-4]と[5-8]が切り替わります。選択されている
ほうのランプが点灯します。

C SCENE (シーン) [1/5][2/6][3/7][4/8]ボタン
それぞれのボタンにパートのパラメーター値やミュート、ミキ
シングの設定の一部などを、シーンとして記録できます。シー
ンセレクト[1-4]/[5-8]ボタンで[1-4]を選ぶと、シーン番号1
～4、[5-8]を選ぶとシーン番号5～8を選べます。

シーン機能に対応したパラメーターを編集し、[SHIFT]ボタン
を押したままSCENE [1/5]～[4/8]ボタンを押すと、それぞれ
のボタンにその情報を記録することができます。ボタンを押す
ことにより、選択したボタンに記録された情報が復元されます。
選択されているボタンは点灯、情報が記録されたボタンは半点
灯、情報が何も記録されていないボタンは消灯します。
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D KNOB POSITION (ノブポジション) [1]、[2]
ボタン

Assign 1～8の値をそれぞれのボタンに記録し、ワンタッチで
切り替えられます。
[SHIFT]ボタンを押したままKNOB POSITION [1]ボタンを押
すとValue1、KNOB POSITION [2]ボタンを押すとValue2
にその情報を記録することができます。
KNOB POSITION [1]と[2]を同時に押すと、Super Knob 
Motion Seqのオンとオフが切り替わります。

E スーパーノブ
ノブに割り当てられたパラメーター (Assign 1～8)の値を同時
にコントロールできます。

NOTE
フットコントローラー (FC7)をご利用することで、足元からスーパーノ
ブをコントロールすることができます。33ページをご参照ください。

F シーケンサートランスポートボタン
ソングシーケンスデータの再生/録音をコントロールします。

[T](トップ)ボタン
ソングの先頭小節まで戻します。

[LL](リワインド)ボタン
ソングの再生位置を1小節ずつ戻します。

[RR](フォワード)ボタン
ソングの再生位置を1小節ずつ進めます。

[I](レコード)ボタン
ソングをレコーディングするページに切り替えます(レコー
ディング画面)。レコーディング画面でこのボタンを押して
レコードセットアップ画面に切り替えると、ボタンが点滅
します。[R](プレイ)ボタンを押して、録音が開始されると
ボタンが点灯します。

[J](ストップ)ボタン
ソングの再生やレコーディングを止めます。
また、鍵盤から指を離しても再生され続けるアルペジオ
(アルペジオ ホールド スイッチがオン状態)を止めたり、ト
リガーを受け取るモーションシーケンスを止めることもで
きます。

[R](プレイ)ボタン
ソングを再生したり、ソングのレコーディングを開始した
りします。再生やレコーディングを開始すると、ボタンが
テンポに合わせて点滅します。

G [RHYTHM PATTERN](リズムパターン)ボタン
リズムパターン画面(43ページ)を表示します。使いたいリズム
パターンを選んでから[PERFORMANCE (HOME)]ボタンか
[EXIT]ボタンを押すと確定できます。
もう一度このボタンを押すと、選択がキャンセルされ、画面が
閉じます。

H [CONTROL ASSIGN] (コントロールアサイン)
ボタン

コントローラーに割り当て可能なパラメーターを画面内で選択
しているときに、このボタンを押し、コントローラーを操作す
ると、そのコントローラーの設定画面が開きます。

I タッチパネルLCD (液晶ディスプレイ)
さまざまな情報を表示します。画面をタッチすることで表示内
容を操作できます。

HG

D

F

E
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J データダイアル 
画面中のカーソルがある位置の値を、変更するときに使います。
右に回す(時計回り)と値が増加し、左に回す(反時計回り)と値が
減少します。設定レンジの広いパラメーターは、ダイアルを速
く回すほど、変化量が大きくなります。

K [DEC/NO] (デック/ノー )ボタン 
画面中のカーソルがある位置の値を、1つずつ減らす(DEC = 
decrement)ことができます。また、ストアやジョブを中止す
る場合の確認(NO)に使用します。
設定レンジの大きいパラメーター値を変更する場合、[SHIFT]
ボタンを押したまま[DEC/NO]ボタンを押すことで、値を10ず
つ減らすことができます。

L [INC/YES] (インク/イエス)ボタン 
画面中のカーソルがある位置の値を、1つずつ増やす(INC = 
increment)ことができます。また、ストアやジョブを実行する
場合の確認(YES)に使用します。
設定レンジの大きいパラメーター値を変更する場合、[SHIFT]
ボタンを押したまま[INC/YES]ボタンを押すことで、値を10
ずつ増加させることができます。

M カーソルボタン 
画面中のカーソルを上下左右に移動させる場合に使用します。

N [EXIT] (エグジット)ボタン 
MODXの画面に表示される機能は階層構造になっています。設
定中に１つ上の階層画面に戻るときに、このボタンを使います。

O [ENTER] (エンター )ボタン
選択した項目の画面を呼び出すときに、このボタンを使います。
また、各ジョブやストア操作の実行と確認(YES)にも使用しま
す。
[SHIFT]ボタンを押したままこのボタンを押すと、テンポセッ
ティング画面を開きます。

P [PERFORMANCE (HOME)] 
(パフォーマンス(ホーム))ボタン

パフォーマンスプレイ画面に戻るときに、このボタンを使いま
す。パフォーマンス画面のときはボタンが点灯し、ユーティリ
ティー画面ではボタンが半点灯します。
パフォーマンスプレイ画面でパフォーマンスネームにカーソル
がある場合、このボタンを押すことで[View]ボタンで表示され
る詳細情報の表示と非表示の切り替えができます。
[SHIFT]ボタンを押したままこのボタンを押すと、オーバー
ビュー画面を開きます。

Q [UTILITY] (ユーティリティー )ボタン
システム全体の設定を行なうユーティリティー画面を表示しま
す。ユーティリティー画面のときはボタンが点灯し、それ以外
の画面ではボタンが半点灯します。
[SHIFT]ボタンを押したままこのボタンを押すと、クイック
セットアップ画面を開きます。
[UTILITY]ボタンを押したまま[PART SELECT MUTE/
SOLO]ボタンを押すと、タッチパネルのキャリブレーション画
面を開きます。

R [EDIT] (エディット)ボタン
パフォーマンス(22ページ)、ライブセット(35ページ)を編集す
る画面を表示します。また、パフォーマンスのパラメーター編
集中に、このボタンを押すことで、編集前と編集後の音を聞き
比べることもできます(コンペア機能)。エディット画面のとき
はボタンが点灯し、コンペア機能中は点滅します。

S [STORE] (ストア)ボタン 
ストア画面を表示します。ストア画面のときはボタンが点灯し、
それ以外の画面ではボタンが半点灯します。

T [SHIFT] (シフト)ボタン 
他のボタンと組み合わせることで、いろいろな働きをします。
実行できる機能については、「シフト機能一覧」(62ページ)を
ご参照ください。

J

K L

M

N O

P

c

Q

R

S

T

a

d

b
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a [LIVE SET] (ライブセット)ボタン
自分の好きなパフォーマンスだけを集めて登録できる「ライブ
セット」を呼び出すボタンです。
また、[SHIFT]ボタンを押したままこのボタンを押すと、現在
選択されているパフォーマンスをライブセットに登録する画面
を開きます。よく使うパフォーマンスをライブセットに登録し
ておけば、ライブ時などにすばやくパフォーマンスを切り替え
ることができます。
ライブセット画面のときはボタンが点灯し、それ以外の画面で
は、ライブセット機能が有効な場合は半点灯、無効な場合は消
灯します。

b [CATEGORY] (カテゴリー )ボタン
カテゴリーサーチ機能(24ページ)を呼び出すときに押すボタン
です。
パフォーマンスプレイ画面で、このボタンを押すとパフォーマ
ンスカテゴリーサーチ画面を開き、全体のパフォーマンスを選
択できます。
パートにカーソルがある場合は、[SHIFT]ボタンを押したまま
このボタンを押すことで、パートカテゴリーサーチ画面を開き、
現在選択されているパートの音色を選択できます。
カテゴリーサーチ画面のときはボタンが点灯し、それ以外の画
面では、カテゴリーサーチ機能が有効な場合は半点灯、無効な
場合は消灯します。

c [PART SELECT MUTE/SOLO] 
(パートセレクト ミュート/ソロ)ボタン

パート選択したり、ミュートやソロのオンとオフを切り替える
ときに押すボタンです。パフォーマンスプレイ画面でこのボタ
ンを押すと、パートセレクトウィンドウが表示されます。

ミュート状態のパートには「M]、ソロ状態のパートには「S」
と表示されます。

パートセレクトウィンドウを閉じるには、ボタンをもう一度押
すか、画面上の「×」をタッチします。

パートセレクトウィンドウの表示中はボタンが点灯、非表示の
ときはボタンが半点灯します。ユーティリティー画面やライブ
セット画面など、パートセレクトを使わない画面ではボタンが
消灯します。

d [AUDITION] (オーディション)ボタン 
パフォーマンスプレイやライブセット、カテゴリーサーチ画面
でこのボタンを押すと、選択中のパフォーマンスの音色による
フレーズ(オーディションフレーズ)を再生/停止します。オンの
ときはボタンが点灯、カテゴリーサーチ画面など、オーディ
ション機能が有効な場合にボタンが半点灯します。

ボタン 操作

1-8 パート1～8を表示

9-16 パート9～16を表示

Select パート選択表示に切り替え

Mute ミュート設定表示に切り替え

Solo ソロ設定表示に切り替え
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リアパネル

外部MIDIキーボード

FC3、
FC4、
FC5

FC4、
FC5

FC7 キーボードアンプ
または

モニタースピーカー

ヘッドフォン

オーディオ機器

マイクなど

コンピューター

USBフラッシュメモリー

1 2

3 4 5 6 87 9

)

■ リアパネル左寄り

■ リアパネル右寄り

イラストは代表してMODX8を掲載しています。
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■ リアパネル左寄り

1 [USB TO HOST]端子
本体とコンピューターのUSB端子とを、USBケーブルで接続す
るために使います。これにより、コンピューターと本体とで
MIDIデータ、オーディオデータの送受信ができます。MIDIケー
ブルでの送受信と違って、USBケーブルではポート信号(56
ページ)を扱えます。MODXで扱えるポートについては、56
ページをご参照ください。

NOTE
オーディオデータの送信は、最大10チャンネル(5ステレオチャンネル)
です。オーディオデータの受信は、最大4チャンネル(2ステレオチャン
ネル)です。

2 [USB TO DEVICE]端子
本体とUSBフラッシュメモリーを接続するために使います。
これにより、本体で制作したデータをUSBフラッシュメモリー
に保存(セーブ)したり、またUSBフラッシュメモリーから本体
へデータを読み込むこと(ロード)ができます。フラッシュメモ
リーと本体とのデータのやりとりは、[UTILITY] → 
[Contents] → [Store/Save] (または[Load])で行ないます。

NOTE
• 本機では、[USB TO DEVICE]端子に接続して使用できるのは、USB
フラッシュメモリーのみです。USB対応のハードディスクドライブや
CD-ROMドライブ、またUSBハブなどは使用できません。

• 本機では、USB1.1～3.0の機器がご使用できますが、機器への保存
や機器からの読み込みにかかる時間は、データの種類や本機の状態に
より異なります。

■ リアパネル右寄り

3 MIDI [IN]、[OUT]端子
MIDI [IN]端子は外部MIDI機器から送信されるMIDIメッセージ
を受信します。外部MIDI機器からMODXをコントロールした
り、音源部を鳴らしたりすることができます。
また、MIDI [OUT]端子からはMODXの演奏情報やパネルのコ
ントローラーやノブなどの操作情報をMIDIメッセージとして送
信します。MODXで他のMIDI音源を鳴らしたり、外部のMIDI
機器をコントロールできます。MIDI [OUT]端子はMIDI Thruと
しても使えます。[UTILITY]ボタンからユーティリティー画面
を開き、設定を切り替えます。

4 FOOT SWITCH [ASSIGNABLE]、[SUSTAIN] 
(フットスイッチ アサイナブル、サステイン)端子

別売のフットスイッチFC3、FC4、FC5を接続します。
[SUSTAIN] (サステイン)端子に接続したフットスイッチはサス
テイン専用に使います。
[ASSIGNABLE] (アサイナブル)端子に接続したフットスイッ
チには、サステイン以外にもさまざまな機能を割り当てること
ができます。
[SUSTAIN]端子にはフットスイッチFC3、FC4、FC5を、
[ASSIGNABLE]端子にはフットスイッチFC4、FC5を使用で
きます。

NOTE
• 本書では、FC3AなどのFC3相当品とFC3をまとめて、「FC3」と
記載します。

• 本書では、FC4AなどのFC4相当品とFC4をまとめて、「FC4」と
記載します。

5 FOOT CONTROLLER [1]、[2] 
(フットコントローラー1、2)端子

別売のフットコントローラー FC7を接続します。パートエ
ディットでさまざまな機能を割り当てることで、音色、音量、
ピッチなどを足元でコントロールできます(リファレンスマニュ
アルをご参照ください)。

6 OUTPUT [L/MONO]、[R] 
(アウトプット左/モノラル、右)端子

MODXのオーディオ信号を出力する端子(標準ジャック)です。モ
ノラル出力したい場合は、[L/MONO]端子だけに接続します。

7 [PHONES] (ヘッドフォン)端子
ヘッドフォンを接続します。ステレオ標準ジャックです。常に
OUTPUT [L/MONO]、[R]と同じ信号が出力されます。

8 A/D INPUT [L/MONO]、[R] 
(A/Dインプット左/モノラル、右)端子

本体へ外部オーディオ信号を入力する端子(標準ジャック)です。
マイクや、CDプレーヤーなどのオーディオ機器、シンセサイ
ザーなどの電子楽器を接続し、入力音声をオーディオ入力パー
トとして鳴らすことができます。
さらにMODXでは、ボコーダーを内蔵音源のエフェクトとして
機能させることができます。ボコーダーを使用するときは、こ
の端子にマイクを接続し、マイクから入力する音声などのオー
ディオ信号によって、ボコーダーのかかりかたをコントロール
できます。
またエンベロープフォロワー機能やABS (オーディオビート
シンク)機能を使う場合にも、この端子を使用します。
エンベロープフォロワーとは、入力信号の波形のエンベロープ
(振幅包絡)を抽出する機能のことで、音色を変化させるコント
ローラーとして使います。

NOTE
• ギター、ベースなどを接続の場合は、ピックアップがアクティブタイ
プのものなら直接接続できますが、パッシブタイプのものはエフェク
ターを介して接続してください。

• ボコーダー、エンベロープフォロワーともにA/D INPUT [L/MONO] 
[R]端子だけではなく、すべてのパート出力によるコントロールができ
ます。

ABS (オーディオビートシンク)とは、この端子に入力される
オーディオのビートを検出し、それとモーションシーケンサー
やアルペジオを同期させる機能です。
接続にはモノラル標準プラグを使います。オーディオ機器など
でステレオ入力の場合は[L/MONO]、[R]端子に接続し、マイ
クなどモノラル入力の場合は[L/MONO]端子に接続します。
エンベロープフォロワー機能やABS機能の詳細については、
リファレンスマニュアルをご参照ください。

9 [P](スタンバイ/オン)スイッチ
電源のスタンバイ/オン スイッチです。

) DC IN (DCイン)端子
付属の電源アダプターを接続する端子です。
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電源の準備
次の順番で、付属の電源アダプターを接続します。電源アダ
プターを接続する前に、本体の[P](スタンバイ/オン)スイッ
チがスタンバイの状態(N)になっていることを確認してくだ
さい。

1 付属の電源アダプターのコードを、リアパネルに
あるコードフックに図のように(参考例)セットし、
プラグをDC IN端子に接続します。 

注記
電源アダプターのコードをコードフックにセットすることによって、
誤ってコードを引っ掛けた場合でも抜けにくくなります。ただし、この
状態でコードを強く締めこんだり、コードを引っ張ったりすることは、
コード表面の摩擦やフックの破損につながりますのでご注意ください。

2 電源アダプターのもう一端のプラグを電源コンセ
ント(AC100V)に接続します。

NOTE
電源アダプターを外すときは、逆の手順で行なってください。

警告
• 電源アダプターは、必ず指定のもの(70ページ)をご使用ください。異
なった電源アダプターを使用すると、故障、発熱、火災などの原因に
なります。このような場合は、保証期間内でも保証いたしかねること
がございますので、十分にご注意ください。

• プラグが外れるタイプの電源アダプ
ターは、必ずプラグを装着した状態で
使用、または保管してください。プラ
グ部分だけをコンセントに差し込む
と、感電や火災の原因になります。

• プラグが外れた場合は、内部の金属部
分に触れないように注意して、カチッ
と音がするまで完全に差し込んでくだ
さい。また異物が入らないようにご注
意ください。感電やショート、故障の
原因になります。

注意
• 本体はコンセントの近くに設置し、異常を感じた場合にはすぐに電源
スイッチを切り、電源プラグをコンセントから抜いてください。

• [ ](スタンバイ/オン)スイッチがスタンバイの状態でも微電流が流れ
ています。長時間使用しないときは、必ず電源アダプターを電源コン
セントから抜いてください。

スピーカーやヘッドフォンの準備
音を鳴らすための準備をします。キーボードアンプやモニ
タースピーカー、ヘッドフォンをご用意いただき、下図のよ
うに接続します。接続の際には、接続する機器をよく確認し
て別途ケーブルをご用意ください。

電源を入れる/切る
電源を入れる前に、MODXとキーボードアンプやモニター
スピーカーのボリュームが、0になっていることを確認しま
す。キーボードアンプやモニタースピーカーに接続している
ときは、次の順番で電源をオン/オフしてください。

電源を入れるとき
ボリュームを0 → MODXをオン(O)(画面が表示され、ボタ
ンが点灯します) → アンプまたはスピーカーをオン

電源を切るとき
ボリュームを0 → アンプまたはスピーカーをオフ → 
MODXをスタンバイ(N)(画面が消え、ボタンが消灯します)

MODXの[P](スタンバイ/オン)スイッチは、鍵盤側から見
てリアパネル左寄りのDC IN端子の右にあります。

ご使用前の準備

コードフック

プラグの付け根部分が
曲がらないよう注意

1

2
電源アダプター

プラグ

矢印の方向へスライドさせて
差し込む

OUTPUT [L/MONO]端子 OUTPUT [R]端子

[PHONES]端子

ヘッドフォン

キーボードアンプ
またはモニタースピーカー

（左側）

キーボードアンプ
またはモニタースピーカー

（右側）

[P](スタンバイ/オン)スイッチDC IN端子
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ご使用前の準備

オートパワーオフ機能
オートパワーオフとは、電源の切り忘れによる無駄な電力消
費を防ぐため、本体が一定時間操作されないと自動的に電源
が切れる機能です。

オートパワーオフの設定
電源が自動的に切れるまでの時間が変更できます。

オートパワーオフの簡単解除
左端の鍵盤を押したまま電源を入れると、「Auto power off 
disabled.」と表示され、オートパワーオフ機能が解除され
ます。この場合、解除の設定は自動的に保存されます。

注記
• 電源が切れた状態でも微電流が流れています。完全に電源を切るには、
電源プラグをコンセントから抜いてください。

• 本体の状態によっては、一定時間操作せずにオートパワーオフの設定
時間が経過しても電源が切れない場合があります。使用後は、手動で
本体の電源を切ってください。

• アンプ、スピーカー、コンピューターなどの外部機器を本体に接続し
た状態で一定時間操作しない場合は、外部機器損傷を防ぐために、取
扱説明書の手順に従って外部機器と本体の電源を切ってください。接
続した状態で自動的に電源が切れるのを避けたい場合は、オートパ
ワーオフを解除してください。

• オートパワーオフで電源が切れた場合、保存していないデータは消去
されます。電源が切れる前に、必ずストア(保存)を実行してください。

• 本体のオートパワーオフ設定が「off」の場合は、外部に保存したシス
テムデータを本体にロードしても、システムデータの設定にかかわら
ず本体の設定は「off」のままになります。本体のオートパワーオフの
時間が設定されている場合は、本体にロードしたシステムデータの設
定に書き換わります。

NOTE
• オートパワーオフの設定時間はおおよその目安です。
• オートパワーオフで電源が切れたあと電源を入れなおす場合は、
[P](スタンバイ/オン)スイッチをいったんスタインバイの位置(N)に
戻してから、もう一度[P](スタンバイ/オン)スイッチを押してくださ
い。

• イニシャライズ オールデータを実行すると、オートパワーオフの設定
が初期値(off)に戻ります。

マスターボリュームを調節する
MODXのボリュームを[MASTER VOLUME]ノブで最適な
位置に調節します。

注意
大きな音量で長時間ヘッドフォンを使用しないでください。聴覚障害の
原因になります。

工場出荷時の状態に戻す
(イニシャライズ オールデータ)
注記
イニシャライズ オールデータを実行すると、現在のユーザーメモリーの
パフォーマンス、ソングなどのデータや、ユーティリティー画面での
システム設定の内容が、すべて工場出荷時の設定に書き換えられてしま
います。大切なデータを失わないようにご注意ください。また、必要な
設定内容は、前もってUSBフラッシュメモリーに保存することをおすす
めします(60ページ)。

1 [UTILITY]ボタンを押すか、画面右上の
[UTILITY]アイコンをタッチして、ユーティリ
ティー画面を表示します。

2 画面左の[Settings]タブをタッチし、次に
[System]タブをタッチします。
システム全般を設定する画面が表示されます。

3 画面右下の[Initialize All Data](イニシャライ
ズ オールデータ)ボタンをタッチします。
実行を確認するダイアログ画面が表示されます。
実行を中止する場合は、画面上の[Cancel No]ボタンを
タッチするか、[DEC/NO]ボタンを押します。

4 画面上の[Yes]ボタンをタッチするか、[INC/
YES]ボタンを押して、イニシャライズ オール
データを実行します。

設定手順 [UTILITY] → [Settings] → [System] → 
[Auto Power Off]

設定値(分) off (オートパワーオフ解除)、5、10、15、
30、60、120

初期設定(分) off

大小
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MODXの画面は、タッチパネルです。画面上の設定/選択したい項目に、直接指で触れて操作できます。また、データダイア
ルやその他のボタンも画面の操作に使います。

画面(タッチパネル)の見かた

ここでは、MODXを起動したときにはじめに開くライブ
セット画面と、ホーム画面であるパフォーマンスプレイ画面
を用いて、全画面で共通に表示されるナビゲーションバーと
画面選択タブについて説明します。

NOTE
電源を入れたときの状態は変更できます。
設定のしかたは51ページをご参照ください。

ライブセット(Live Set)画面 

1 HOME (ホーム)アイコン
パフォーマンスプレイ画面に移動します。

2 EXIT (エグジット)アイコン
パネル上の[EXIT]ボタンと同様の機能です。設定中に
1つ上の階層画面に戻るときに、このアイコンを使いま
す。

3 INFORMATION (インフォメーション)エリア
選択中の画面名などの情報を表示します。

4 EFFECT (エフェクト)アイコン
エフェクトスイッチ画面を開きます。インサーションエ
フェクト/システムエフェクト/マスターエフェクトのい
ずれかがオフになると、アイコンが消灯します。

5 QUICK SETUP (クイックセットアップ)アイ
コン
ローカルコントロール オン/オフ、MIDI IN/OUT設定を
表示します。
ローカルコントロールオンの場合は鍵盤のアイコンが点
灯し、ローカルコントロールオフの場合は鍵盤のアイコ
ンが消灯します。
MIDI IN/OUT設定がMIDIの場合は、MIDI端子のアイコ
ンが表示されます。MIDI IN/OUT設定がUSBの場合は、
USBアイコンが表示されます。
アイコンをタッチするとクイックセットアップ画面を開
きます。

6 TEMPO SETTINGS (テンポセッティング)
アイコン
現在選択されているパフォーマンスのテンポを表示しま
す。アイコンをタッチするとテンポセッティング画面を
開きます。

7 UTILITY (ユーティリティー )アイコン
アイコンをタッチするとユーティリティー画面のうち、
直前に開いた画面を開きます。

パフォーマンスプレイ画面 

8 LIVE SET (ライブセット)アイコン
アイコンをタッチするとライブセット画面を開きます。

9 画面選択タブ
それぞれのタブをタッチすると対応した画面が開きま
す。

) View (ビュー )ボタン
各パートに関する情報を詳細表示するか(On)/しないか
(Off)を設定します。表示される情報はカーソルの位置や
スライダーファンクションの設定によって切り替わりま
す。

カーソル移動

4つのカーソルボタン(上下左右)を使って、画面上のカーソ
ル(反転表示部分)を上下左右方向に順番に移動させることが
できます。カーソルが置かれている位置の値を、データダイ
アルや[INC/YES]ボタン、[DEC/NO]ボタンで変更します。

基本操作と画面表示 

12 76543

ナビゲーションバー

9

8)
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基本操作と画面表示

値の変更/設定

データダイアルを右方向(時計回り)に回すと値が増加し、
左方向(反時計回り)に回すと値が減少します。
[INC/YES]ボタンを押すたびに値が1ずつ増加し、[DEC/
NO]ボタンを押すたびに値が1ずつ減少します。
設定レンジの大きいパラメーター値を変更する場合、
[SHIFT]ボタンを押したまま[INC/YES]ボタンを押すこと
で、値を10ずつ増加させることができます。逆に[SHIFT]
ボタンを押したまま[DEC/NO]ボタンを押すことで、値を
10ずつ減らすことができます。

文字入力

パフォーマンスネームやソングネームなど、文字を入力する
パラメーターをタッチ、もしくはカーソルを移動し
[ENTER]ボタンを押すと、以下の画面が表示され、文字を
入力する状態になります。

1 すべての文字を削除します。

2 この画面を表示したときの文字列に戻します。

3 大文字/小文字を切り替えます。

4 記号入力に切り替わります。

5 カーソル位置にスペースを挿入します。（[INC/YES]ボ
タンを押すことでも同様の操作ができます。）

6 カーソルを移動します。

7 一文字削除します。（[DEC/NO]ボタンを押すことでも
同様の操作ができます。）

8 文字入力を完了し、この画面を閉じます。

鍵盤入力とテンキー入力

特定のパラメーターでは、鍵盤を押さえて数値を入力する方
法(鍵盤入力)や画面にテンキーを表示させて数値を入力する
方法(テンキー入力)が使えます。鍵盤入力は値としてノート
またはベロシティーを入力するパラメーターで有効となり、
テンキー入力は値を入力するパラメーターで有効となりま
す。対象のパラメーターをタッチ、もしくはカーソルを移動
し[ENTER]ボタンを押すと、以下のメニューが開きます。

1 鍵盤入力が有効となります。
鍵盤を押すと、押した鍵盤のノートまたはベロシティー
が入力されます。

2 テンキー入力の画面が開きます。
このとき、テンキーによる数値の直接入力のほか、デー
タダイアル、[INC/YES]ボタン、[DEC/NO]ボタンに
よる数値の増減ができます。

3 すべての数字を削除します。

4 この画面を表示したときの数値に戻します。

5 最下位の数字を削除します。

6 数値入力を完了し、この画面を閉じます。

値が減少

値が1ずつ減少 値が1ずつ増加

値が増加

3

4

21

5 6

7

8

1

2

43

5

6

テンキー入力画面
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MODXは16パートで構成されており、各パートには
MODXのサウンドの基本となる楽器音が割り当てられてい
ます。それらの音色セットをパフォーマンスと呼び、
MODXではこのパフォーマンスを選ぶことで音色を切り替
えます。

パフォーマンスを構成するパートには、以下の3種類があり
ます。

ノーマルパート(AWM2)
ピアノ、オルガン、ギター、シンセサイザーなどさまざまな
楽器の音色のパートです。鍵盤の音階に合った音の高さで発
音します。

ノーマルパート(FM-X)
FM-X音源による音色のパートです。鍵盤の音階に合った音
の高さで発音します。

ドラムパート
リズムパートを演奏する場合に使う音色のパートです。各
ノートナンバー (鍵盤)にいろいろな打楽器が割り当てられて
います。

また、パフォーマンスには大きく分けて以下の2種類があり
ます。

シングルパートパフォーマンス
単独のパートから構成されるパフォーマンスです。単体の楽
器の音色を鳴らしたい場合はこちらを選択します。

マルチパートパフォーマンス
複数のパートから構成されるパフォーマンスです。複数の楽
器の音色をレイヤー /スプリットさせて鳴らしたい場合はこ
ちらを選択します。

MODXには、パフォーマンスを記憶させるためのバンクが
用意されています。バンクの種類には、大きく分けて
プリセットバンク、ユーザーバンク、ライブラリーバンク、
GMバンクがあります。各バンクは、記憶されている
パフォーマンスや役割が下記のように異なります。

プリセットバンク
あらかじめ本体に内蔵されたパフォーマンスが入っていま
す。プリセットバンクには、パフォーマンスを保存できませ
ん。

ユーザーバンク
パフォーマンスエディットで作ったパフォーマンスを保存
(ストア)しておくバンクです。初期は空の状態となっていま
す。
注記
ユーザーバンクのパフォーマンスは、上書きされると消えてしまいます。
エディットしたパフォーマンスを保存する場合は、大事なユーザーパ
フォーマンスに上書き保存しないようにご注意ください。

ライブラリーバンク
ライブラリーとして本体に追加されたパフォーマンスが入っ
ています。初期は空の状態となっています。
（ライブラリーの追加はライブラリーファイルを読み込むこ
とで行ないます。）

GMバンク
GM音色として規定されたパートが入っています。

各バンクには、パフォーマンスが種類別に記憶されています。

NOTE 
• パフォーマンスについて詳しくは、PDFファイル「リファレンスマ
ニュアル」の「MODXのしくみ」をご覧ください。

• パフォーマンスの一覧は、PDFファイル「データリスト」をご覧くだ
さい。

はじめて電源を起動した後に表示されるトップ画面では、
プリセットバンクのライブセットが表示されます。
ライブセットとは、パフォーマンスを任意の順番に並べた
リストのことで、１ページあたり16個のパフォーマンスを
並べることができます。あらかじめ用意されているライブ
セットから、さまざまなパフォーマンスを選んで演奏してみ
ましょう。

音色(パフォーマンス)を選ぶ

1つのパフォーマンス

パート1（ピアノ）

パート２（ギター）

パート3（ベース）

パート4（ドラム）

パート16

複数個の
パフォーマンス

GM音色
GMとは、メーカーや機種が異なった音源でも、ほぼ同じ
系統の音色で演奏が再現されることを目的に設けられた、
音源の音色配列やMIDI機能に関する一定の基準のことで
す。本体のGMバンクは、GM対応のソングデータがほぼ
正常に再生できることを目的にしており、GMに完全に対
応しているわけではありません。
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音色(パフォーマンス)を選ぶ

ライブセットからパフォーマンスを
選ぶ

1 [LIVE SET]ボタンを押します。
ライブセット画面が開きます。

1 ページ(画面上の[∧][∨]ボタンでページ切り替え)
NOTE
[SHIFT]+[INC/YES]または[DEC/NO] でも同様の操作が可能
です。

2 プリセットバンク/ユーザーバンク(画面上の[∧][∨]
ボタンで切り替え)

3 パフォーマンスリスト

4 選択中のパフォーマンスネーム

5 スロットネーム

6 フラグ

NOTE
Seamless Sound Switching (シームレス サウンド スイッチング)
とは、パフォーマンスを別のパフォーマンスに切り替えたときに、
音切れすることなく自然につなぐ技術です。
SSSは1～4パートから構成されるパフォーマンスには有効ですが、
5～16パートを使っているパフォーマンスには無効となります。

2 画面上の好きなパフォーマンスをタッチして選び
ます。
NOTE
ライブセットに登録したパフォーマンスを並べ替える方法は35ペー
ジをご参照ください。

3 鍵盤を弾いてみましょう。

パフォーマンスを切り替える

1 [PERFORMANCE (HOME)]ボタンを押しま
す。
パフォーマンスプレイ画面が表示され、現在選択されて
いるパフォーマンスネームが確認できます。

2 パフォーマンスネームにカーソルを合わせ、デー
タダイアルや[INC/YES]、[DEC/NO]ボタンで
パフォーマンスを選択します。
NOTE
• [SHIFT]ボタンを押したまま[INC/YES]ボタンを押すと、
パフォーマンスナンバーの値が10増加します。

• [SHIFT]ボタンを押したまま[DEC/NO]ボタンを押すと、
パフォーマンスナンバーの値が10減少します。

3 鍵盤を弾いてみましょう。

フラグの表記と意味

表記 意味

AWM2 AWM2音源のパートのみで構成される
パフォーマンス

FM-X FM-X音源のパートのみで構成されるパフォー
マンス

AWM2＋FM-X AWM2音源のパートとFM-X音源のパートから
構成されるパフォーマンス

MC モーションコントロールをフィーチャーした
パフォーマンス

SSS Seamless Sound Switching (シームレス 
サウンド スイッチング)に対応したパフォーマ
ンス

12

5 6

3

4
パフォーマンスネーム
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音色(パフォーマンス)を選ぶ

楽器の種類でパフォーマンスを選ぶ
(カテゴリーサーチを使う)
MODXのパフォーマンスは、カテゴリーごとに分類されて
います。カテゴリーは、パフォーマンスをピアノ、オルガン
といった楽器の種類や音のキャラクター別に分けたもので
す。カテゴリーサーチは、特定のカテゴリーを指定して、そ
の中から使いたいパフォーマンスをすばやく探すことができ
る便利な機能です。

1 [CATEGORY]ボタンを押します。
カテゴリーサーチ画面が表示されます。

NOTE
パフォーマンスネームをタッチしたときに表示されるメニューから
[Category Search]を選択して、カテゴリーサーチ画面を開くこと
もできます。

1 バンク

2 アトリビュート
NOTE
アトリビュートとはパフォーマンスの属性のことで、音源方式
やパフォーマンスのパート構成などにより分類されます。

3 キーワード検索

4 メインカテゴリー

5 サブカテゴリー

6 選択したカテゴリーのパフォーマンスリスト
NOTE
現在選択中のパフォーマンスは白色、シングルパートの
パフォーマンスは緑色、マルチパートのパフォーマンスは青色
で表示されます。

7 ソート順の切り替え

8 パフォーマンスリストのページ切り替え

9 お気に入りリストへの追加と削除

2 メインカテゴリー (4)をタッチし、選択します。
NOTE
• [Bank](バンク1)をタッチし、表示された候補の一覧からバンク
の種類を選択することで、パフォーマンスリストのフィルタリン
グができます。

• [Attribute](アトリビュート2)をタッチし、表示された候補の一
覧からアトリビュートの種類を選択することで、パフォーマンス
リストのフィルタリングができます。

• 画面の[Set](フェーバリット セット9)にタッチし、フェーバ
リットマークをつけることで、お気に入りの音色をすばやく見つ
けることができます。

3 サブカテゴリー (5)をタッチし、選択します。
選択したカテゴリーのパフォーマンスリスト(6)が表示
されます。

4 パフォーマンスをタッチし、選択します。

5 HOMEアイコン/EXITアイコンをタッチし、
パフォーマンスを確定します。
カテゴリーサーチ画面が閉じます。

NOTE
[ENTER]ボタン、[EXIT]ボタンもしくは[PERFORMANCE 
(HOME)]ボタンを使って確定させることもできます。

6 鍵盤を弾いてみましょう。

6

4

5

1 2 3

7 89

パフォーマンスのカテゴリー表記と意味

表記 意味

Piano ピアノ

Keyboard キーボード(エレクトリックピアノやクラビ
など)

Organ オルガン

Guitar ギター

Bass ベース

Strings ストリングス(バイオリンなどの弦楽器および
弦楽器アンサンブル)

Brass ブラス(トランペットなどの金管楽器)

Woodwind 木管楽器

Syn Lead シンセリード(メロディーやソロを演奏するの
に適したシンセ音)

Pad/Choir シンセパッド(拡がりと厚みのあるシンセ音)

Syn Comp シンセコンプ(コンピング奏法を行なうのに
適したシンセ音)

Chromatic Perc クロマティックパーカッション(マリンバや
グロッケンなど音階を持った打楽器)

Drum/Perc ドラム/パーカッション

Sound FX サウンドエフェクト(効果音)

Musical FX ミュージカルエフェクト(音階を持った効果音)

Ethnic エスニック(民族楽器)

No Assign ノーアサイン(未分類)

Init イニシャライズ(初期化)
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音色(パフォーマンス)を選ぶ

オーディションフレーズを聞く
MODXでは、音色を選ぶ際、オーディションフレーズを再
生させることで内蔵されているパフォーマンスの音色を簡単
に確認できます。

1 カテゴリーサーチ画面で、画面上の[Audition]
ボタンをタッチします。
現在選択されているパフォーマンスによるオーディショ
ンフレーズが再生されます。

オーディションフレーズの再生中にパフォーマンスを切
り替えると、切り替わったパフォーマンスのオーディ
ションフレーズが再生されます。

2 再度[Audition]ボタンをタッチすると、オーディ
ションフレーズの再生が停止します。

NOTE
• パネル上の[AUDITION]ボタンを押すことでもオーディションフレー
ズの再生/停止ができます。

• パフォーマンス画面、ライブセット画面でも[AUDITION]ボタンを押
すことで、オーディションフレーズの再生/停止ができます。

イニシャライズパフォーマンスを選ぶ
以下の手順でイニシャライズパフォーマンスを選ぶことが
できます。

1 カテゴリーサーチ画面でメインカテゴリーの
[Init]をタッチします。

2 パフォーマンスリストにイニシャライズ
パフォーマンスのみが表示されます。
[Init Normal (AWM2)]はノーマルパート(AWM2)の
イニシャライズパフォーマンス、[Init Normal (FM-X)]
はノーマルパート(FM-X)のイニシャライズパフォーマ
ンス、[Init Drum]はドラムパートのイニシャライズパ
フォーマンスです。

3 パフォーマンスを選びます。

シングルパートパフォーマンスをフィルタリング
する
アトリビュートを使ってシングルパートパフォーマンスを
フィルタリングしてみましょう。

1 カテゴリーサーチ画面で[Attribute](アトリ
ビュート2)をタッチします。

2 画面左のメニューから[Single]をタッチしま
す。

3 パフォーマンスリストにシングルパート
パフォーマンスのみが表示されます。

オーディションボタン
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MODXでは、最大8個のパートを重ねて迫力や厚みのある音を出すことができます。[PERFORMANCE (HOME)]ボタンを押
して演奏してみましょう。

パフォーマンスプレイの表示画面
この時点で鍵盤を弾くと、現在画面上に表示されているパフォーマンスの音が出ます。
また、パフォーマンスプレイ画面に表示されている各項目は以下のとおりです。画面上のアイコンをそれぞれタッチすること
で、操作できます。

1 パフォーマンスネーム

2 フラグ

3 ノブの機能

4 パートネーム

5 パートのモーションシーケンサー オン/オフを切り替え

6 パートのアルペジオ オン/オフを切り替え

7 パートのノートリミット

8 パートのキーボードコントロール オン/オフを切り替え

9 パートのミュート オン/オフを切り替え

) パートのソロ オン/オフを切り替え

! パート1～8のボリューム

@ メーター (オーディオ出力レベル)

# 各パートに関する情報の詳細表示 オン/オフを切り替え

演奏する

1#

! @

3

2

4

7

8

9

)

56
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パートのオン/オフを切り替える
パフォーマンスを構成する8パートの発音を次の操作でオン
/オフできます。

パートのオン/オフを切り替える(ミュート
機能)

パートをオフにして発音しない状態にすることをミュートと
呼びます。

1 [PERFORMANCE (HOME)]ボタンを押しま
す。
[PERFORMANCE (HOME)]ボタンが点灯し、パート
ごとのオン/オフを切り替える状態になります。

2 画面上の[MUTE]ボタンにタッチすると、その
パートがミュートされます。
同じボタンをもう一度タッチすると、ボタンが消灯して
ミュートが解除されます。複数のボタンをタッチする
と、複数のパートをミュートできます。

[PART SELECT MUTE/SOLO]ボタンを使ってもパート
をミュートすることができます。

1 パフォーマンス画面が表示された状態で[PART 
SELECT MUTE/SOLO]ボタンを押します。
画面にパートセレクトウィンドウが表示されます。

2 パートセレクトウィンドウ内の[MUTE]ボタンに
タッチします。

3 ミュートしたいパートと同じ番号のボタンをタッ
チすると「M」と表示され、対応するパートが
ミュートされます。
複数のパートをミュートすることも可能です。

4「MUTE」を選んだ状態で「M」と表示されてい
るボタンをタッチすると、「M」の表示が消えると
ともに、対応するパートのミュートが解除されま
す。

特定のパートだけをオンにする(ソロ機能)

特定のパートだけを発音状態にすることをソロと呼びます。

1 [PERFORMANCE (HOME)]ボタンを押しま
す。

2 画面上の[SOLO]ボタンをタッチすると、その
パートがソロになります。
[SOLO]ボタンが点灯し、ソロ機能が有効になります。
同じボタンをもう一度タッチすると、ボタンが消灯して
ソロが解除されます。

[PART SELECT MUTE/SOLO]ボタンを使ってもパート
のソロ機能を設定することができます。

1 パフォーマンス画面が表示された状態で[PART 
SELECT MUTE/SOLO]ボタンを押します。
画面にパートセレクトウィンドウが表示されます。

2 ソロに設定したいパートを選びます。

3 パートセレクトウィンドウ内の[SOLO]ボタンに
タッチします。
現在選択中のパートに「S」と表示され、ソロ状態にな
ります。

4「S」と表示されているボタンをタッチすると「S」
の表示が消えるとともにソロが解除されます。
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アルペジオを使う
MODXにはアルペジオ機能が搭載されていて、鍵盤を押さ
えるだけでリズムパターンやコードバッキングを演奏させる
ことができます。
アルペジオは、ライブパフォーマンスでの表現の幅を広げる
ツールとしてだけではなく、楽曲制作でも目的の楽器や音楽
ジャンルにぴったり合ったバッキングフレーズを作成する
ツールとして機能します。
あらかじめ、音色やフレーズに合わせてパートごとに、最大
8つまで、好きなアルペジオタイプを設定しておくことがで
き、同時に8パートまでのアルペジオ設定を有効にできま
す。
また、アルペジオ再生させるノートリミット(キーの範囲)や
ベロシティーリミット(鍵盤を押す強さの範囲)を設定した
り、アルペジオ再生の仕方やプレイエフェクトを設定するこ
ともできます。

NOTE
アルペジオ機能のしくみについては、PDFファイル「リファレンスマ
ニュアル」をご参照ください。

アルペジオをオン/オフする

アルペジオのオン/オフを切り替えるには、パネルの[ARP 
ON/OFF]ボタンを押します。

アルペジオの種類の変更や演奏中の切り替えかたについて
は、「シーン機能を使う」(34ページ)をご覧ください。

モーションシーケンサーを使う
モーションシーケンサーとは、あらかじめ作成したシーケン
スによってパラメーターを操作し、音色を変化させる機能で
す。
パフォーマンスのテンポやアルペジオ、接続した機器のリズ
ムに同期させるなど曲の展開に応じたリズミカルな音の変化
をインタラクティブかつリアルタイムに作り出すことができ
ます。
曲の展開やシーンに合わせてレーン(系統)ごとに8つ、好き
なシーケンスタイプを設定しておくことができます。
また、1パートにつき最大4レーンのモーションシーケン
サーが使用でき、パフォーマンス全体で同時に8レーンまで
を使用できます。
アルペジオと同様にシーケンスを再生させるベロシティーリ
ミット(鍵盤を押す強さの範囲)を設定したり、シーケンス再
生の仕方やステップ数などを設定したりすることもできま
す。

NOTE
モーションシーケンサーのしくみについては、PDFファイル「リファレ
ンスマニュアル」をご参照ください。

モーションシーケンサーをオン/オフする

モーションシーケンサーのオン/オフを切り替えるには、
パネルの[MS ON/OFF]ボタンを押します。

モーションシーケンサーの種類の変更や演奏中の切り替えか
たについては、「シーン機能を使う」(34ページ)をご覧くだ
さい。
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コントローラーを使って音色を変化させる
MODXには、ピッチベンドホイールやモジュレーションホイール、アサイナブルスイッチボタン1/2、スーパーノブ、ノブ、
コントロールスライダーなど、多くのコントローラーが装備されていて、音にさまざまな変化をつけることができます。

ノブ

スーパーノブ

コントロールスライダー

モジュレーションホイール

[ASSIGN 1]/[ASSIGN 2] ボタン

ピッチベンドホイール



MODX 取扱説明書30

演奏する

ノブを使って音色を変化させる
ノブ1～4 (5～8)を操作すると、選択中のパフォーマンスまたはパートのパラメーターやエフェクトのかかり具合をコント
ロールすることで音色を変化させることができます。ノブの機能は、ノブファンクションボタン、[ASSIGN]ボタンで切り替
えることができます。パフォーマンス全体をコントロールする方法と、特定のパートをコントロールする方法があります。

● パフォーマンス全体をコントロールする方法
画面内でパフォーマンスネームにカーソルを置くか、[PART SELECT MUTE/SOLO]ボタンを押して「Common」を選
び、本体を「パフォーマンスコントロール状態」にしてから、ノブ1～4 (5～8)を操作します。

● 特定のパートをコントロールする方法
画面内でパートネームにカーソルを置くか、[PART SELECT MUTE/SOLO]ボタンを押して1から16のいずれかを選び、
本体を「パートコントロール状態」にしてから、ノブ1～4 (5～8)を操作します。

1 ノブファンクション[TONE]/[EG/FX]/[EQ]/[ARP/MS]ボタンもしくは[ASSIGN]ボタンを押して、
切り替えたい機能に該当するボタンを点灯させます。

1 [TONE]: 音色設定に関する機能に切り替えます。

2 [EG/FX]: エンベロープジェネレーターやエフェクト設定に関する機能に切り替えます。

3 [EQ]: イコライザー設定に関する機能に切り替えます。

4 [ARP/MS]: アルペジオやモーションシーケンサーの再生に関する機能に切り替えます。

画面に、ノブ1～4 (5～8)に割り当てられている機能とその機能の現在の値が表示されます。

2 鍵盤を弾きながら、本体のノブ1～4 (5～8)のいずれかを回します。
画面上の各パラメーターの値が変化し、操作した機能が音色に効果します。

ノブ1 ノブ２ ノブ３ ノブ４

スーパーノブ

1
2
3
4

ノブ1～8に割り当てられている機能
各機能の現在の値
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スーパーノブを使って音色を変化さ
せる
スーパーノブを使うと、8つのノブに割り当てられた全パー
ト共通のAssign 1～8の機能の値を同時にコントロールで
きます。
スーパーノブとモーションシーケンサーを組み合わせて使う
ことで、複雑な音の変化を実現できます。
スーパーノブはノブファンクションボタンや[ASSIGN]ボタ
ンを押さなくても、常に有効な状態となっています。

スーパーノブの設定例

ここでは、プリセットパフォーマンスから、アコースティック
ピアノとパッドサウンドを選択してレイヤー音色を作成し、
もともと設定されているそれぞれのスーパーノブの効果は保
持しつつ、モーフィング効果を付加する例を説明します。
 

レイヤー音色設定

1 パート1の音色を選びます。

1-1. [CATEGORY]ボタンを押して、
「CFX PopStudioGrand」 を選びます。

2 パート2の音色を選びます。

2-1. パフォーマンスプレイ画面でパート2を選択し、
[SHIFT]ボタンを押したまま[CATEGORY]ボタン
を押して、「Ethereal」 を選びます。

3 設定を確認します。

3-1. [Motion Control]タブ → [Overview]タブをタッ
チします。
モーションコントロールのオーバービュー画面が
開きます。

3-2. パートの[Common]、 [1]、[2]をタッチして、
Assignableのノブ6と7には緑の線がつながって
いない(未使用である)ことを確認します。
必要に応じて[ASSIGN]ボタンを押し、表示を切
り替えると、ノブ5～8の状態が確認できます。

4 パート1の音色のパラメーターを設定します。

4-1. [Super Knob]タブをタッチします。
モーションコントロールのスーパーノブ画面が開
きます。

4-2. [Edit Super Knob]ボタンをタッチします。
コモン/オーディオエディットのコントロールアサ
イン画面が開きます。

4-3. [＋]ボタンをタッチします。
[＋]ボタンが表示されていなければ、[>]ボタンを
タッチして Page 2に切り替えてから[＋]ボタン
をタッチします。

Destination 6が追加されます。

4-4. [Destination 6]タブを選んだ状態で、Sourceを 
AsgnKnob 6、[Destination 6]をPart 1 
Assign 6に設定します。

4-5. [Edit Part 1 Control Settings]ボタンをタッチ
します。
エレメントコモンエディットのコントロールアサ
イン画面が開きます。

アコースティック
ピアノ

パッド
サウンド

プリセット

3-2

4-3

4-44-4 4-5
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4-6. [＋]ボタンをタッチします。
[＋]ボタンが表示されていなければ、[>]ボタンを
タッチして Page 2に切り替えてから[＋]ボタン
をタッチします。

4-7. [Destination 10]タブをタッチして、Part 
ParamからVolumeを選びます。

4-8. 必要に応じてその他のパラメーターを調節します。
ここでは、カーブボラリティー (Polarity)を 
「Bi」、カーブレシオ(Ratio)を 「+63」などにし
ます。

5 パート2の音色のパラメーターを設定します。

5-1. [Edit Common Control Settings]ボタンをタッ
チします。
コモン/オーディオエディットのコントロールアサ
イン画面が開きます。

5-2. [＋]ボタンをタッチします。
Destination 7が追加されます。

5-3. [Destination 7]タブを選んだ状態で、Sourceを 
AsgnKnob 7、[Destination 7]をPart 2 
Assign 7に設定します。

5-4. [Edit Part 2 Control Settings]ボタンをタッチ
します。
パート1と同じように設定します。
ここでは、カーブボラリティー (Polarity)を 
「Bi」、カーブレシオ(Ratio) を 「-64」などにし
ます。

以上で設定できました。

● 微調整する場合
[Edit Common Control Settings]ボタンをタッチし
てDestination 6と7を切り替え、Curve TypeやRatio
などを調整する。

もしくは

KNOB POSITION [1]を押してから、左いっぱいに 
スーパーノブを回し切ったときの音をノブ6と7を回し
て設定し、[SHIFT]+[1]でストアする。次にKNOB 
POSITION [2]を押してから、同様に右いっぱいに回し
た状態を設定し、[SHIFT]+[2]でストアする。

スーパーノブの効果を設定する

ここではスーパーノブの操作によって変化するパラメーター
の値を確認する手順を説明します。

1 [PERFOMANCE (HOME)]ボタンを押します。
ボタンが点灯し、全パート共通の設定ができる状態にな
ります。

2 [View]ボタンがオフの状態で[ASSIGN]ボタン
を押して、Common Assign1-4または
Common Assign5-8を選びます。
Common Assign1-4を選ぶと[ASSIGN]ボタンが点
灯、Common Assign5-8を選ぶと[ASSIGN]ボタンが
点滅します。
画面にノブ1～4 (5～8)に割り当てられている機能が表
示され、それらの現在の値が表示されます。

3 鍵盤を弾きながら、スーパーノブを回します。
画面上の各パラメーターの値が連動して変化し、すべて
の機能が音色に反映されます。

NOTE
スーパーノブの設定方法はリファレンスマニュアルをご参照くださ
い。

スーパーノブに割り当てられているパラ
メーターを確認する

スーパーノブにどのパラメーターが割り当てられているかは
スーパーノブ画面で確認します。

1 パフォーマンスプレイ画面で画面左の[Motion 
Control]タブをタッチします。

2 画面左内側の[Super Knob]タブをタッチしま
す。
スーパーノブ画面が表示されます。

3 スーパーノブ画面の[Edit Super Knob]をタッ
チします。
コントロールアサイン画面が表示されます。

ここでスーパーノブの詳細設定を1画面で確認できます。
設定の変更が必要な場合は、ここで設定を変更します。

NOTE
コントロールアサイン画面は、パフォーマンスエディット画面を開いた
あと、画面左の[Control]タブ → [Control Assign]タブをタッチしても
開けます。

4-85-1
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ミキシングをする
ミキシングとは、パフォーマンスを構成する16パートにお
いて、各パートごとにさまざまな設定ができる機能です。
各々のパートのパン、ボリューム、その他の設定の確認や、
各ミキシングパラメーターの設定を調節します。

ミキシングをする基本手順

1 パフォーマンスプレイ画面で画面左の[Mixing]
タブをタッチします。
ミキシング画面が表示されます。

1 各パートのメインカテゴリー

2 3-band EQ/2-band EQの表示切り替え

3 各パートのEQ設定

4 各パートのパラメーター値

5 1～16パート表示に切り替え

6 オーディオパート表示(9～16パート非表示)に切り
替え

2 [PART SELECT MUTE/SOLO]ボタン → [1]
～[16]ボタンをタッチして、設定の確認や調整を
行ないたいパートを選びます。
NOTE
画面上の[Audio]ボタン(6)を押すことにより、オーディオパートが
表示されます。このパートではA/D INPUT [L/MONO]、[R]端子か
ら入力される音声(ADパート)や、[USB TO HOST]端子から入力さ
れる音声(Digitalパート)*に関するパラメーターを設定できます。

*デバイスポートのうち、「Digtal L/R」に設定された音声

3 各パートのパラメーターにカーソルを移動し、
データダイアルを回して値を変更してみましょう。
NOTE
• パートの設定について、さらに細かく変更する場合には、ミキシ
ング画面から[EDIT]ボタンを押してエディット画面に入ります。

• ミキシングパラメーターの詳細やミキシングエディットについて
は、リファレンスマニュアルをご参照ください。

スーパーノブを足元でコントロールする
以下の手順でフットコントローラー (FC7)を使ってスー
パーノブをコントロールできます。

1 フットコントローラー (FC7)をFOOT 
CONTROLLER [1]端子もしくはFOOT 
CONTROLLER [2]端子に接続します。

2 パフォーマンスプレイ画面でカーソルを
パフォーマンスネームに合わせ、[EDIT]ボタン
を押します。

3 画面左の[Control]タブ → [Control 
Number]タブをタッチします。

4 フットコントローラー (FC7)を接続した端子に
応じて「Foot Ctrl1」もしくは「Foot 
Ctrl2」を「Super Knob」に設定します。

1

4

2

5

6

3
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シーン機能を使う
シーンとは、8つの[SCENE]ボタンそれぞれにアルペジオ
タイプやモーションシーケンスタイプ、パートのパラメー
ター値などの設定を記録する機能です。
ひとつのパフォーマンスの中で、曲の展開に応じてアルペジ
オタイプやモーションシーケンスタイプなどを同時に切り替
えたり、異なる表情の音色に切り替えたい場合に便利です。

シーンを設定する手順

1 パフォーマンスプレイ画面で画面左の[Scene]
タブをタッチします。
シーン画面が表示されます。

1 シーン1～8切り替え

2 各機能シーン設定のオン/オフ切り替え

3 全パートのモーションシーケンサーのオン/オフ切り
替え

4 選択中のシーンに記録されているモーションシーケ
ンスタイプ

5 全パートのアルペジオのオン/オフ切り替え

6 選択中のシーンに記録されているアルペジオタイプ

NOTE
3～6は、2のタブで「Arp」「Motion Seq」を選択しているとき
のみ表示されます。この部分は、選択しているタブ(機能)に応じて表
示が変わります。

2 シーン1～8の設定をします。
2の[Memory]をオンにした機能やモーションシーケン
スタイプ、アルペジオタイプの情報は、選択中の
[SCENE]ボタンに自動で記録されます。SCENE [1]～
[8]ボタンを押すことにより、シーン1～8が切り替わ
り、各ボタンに記録された情報が復元されます。

NOTE
シーン機能は、シーン画面以外でも設定できます。シーン画面で設
定できるパラメーターがアサインされているノブやコントロールス
ライダーなどでパラメーターを変更した後、[SHIFT]ボタンを押し
たままSCENE [1]～[8]ボタンを押すことで、シーン1～8をそれぞ
れのボタンに記録できます。

3 必要に応じてパフォーマンスを保存します(37
ページ)。
注記
保存(ストア)をせずに別のパフォーマンスを選んだり電源を切った
りすると、シーンの設定内容は消えてしまいます。

1

2

4

3

6

5
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ライブのときに、曲に合わせてパフォーマンスを瞬時に切り替えたいときは、ライブセットを使うと便利です。MODXでは、
お気に入りのパフォーマンスを並べることで簡単にオリジナルのライブセットを作ることができます。

パフォーマンスをライブセットに
登録する
パフォーマンスのライブセットへの登録は以下の手順で操作
します。

注記
• 編集中のパフォーマンスをライブセットに登録する場合は、先に
パフォーマンスを保存(ストア)してください(37ページ)。

• 保存(ストア)をせずに別のパフォーマンスを選んだり電源を切ったり
すると、編集中の内容は消えてしまいます。

1 登録したいパフォーマンスを選びます。

2 [SHIFT]ボタンを押したまま[LIVE SET]ボタン
を押します。
ライブセット画面が表示されます。

3 任意のスロットをタッチすると、そのスロットに
選択中のパフォーマンスが登録されます。

ライブセット画面 

ライブセットに登録したパフォーマ
ンスを並べ替える
ライブセットに登録したパフォーマンスの順番を並べ替えた
いときは、ライブセットエディット画面から行ないます。

1 ライブセット画面で、[EDIT]ボタンを押します。
ライブセットエディット画面が表示されます。
(プリセットバンク/ライブラリーバンクのライブセット
を開いているときは表示されません。）

2 移動元のスロットを選択し、画面上の[Swap]
ボタンをタッチします。
[Swap]ボタンが点灯し、有効になります。

3 移動先のスロットを選択します。
移動元と移動先のスロットの中身が入れ替わります。

オリジナルのライブセットを作る

空きスロットに登録されたパフォーマンス 空きスロット



MODX 取扱説明書36

オリジナルのライブセットを作る

ライブセットに登録したパフォーマンスを足元で
切り替える
以下の設定により、フットスイッチ(FC4、FC5)を使って
パフォーマンスを切り替えることができます。

1 フットスイッチ(FC4、FC5)をFOOT 
SWITCH [ASSIGNABLE](フットスイッチ 
アサイナブル)端子に接続します。

2 [UTILITY]ボタンを押してユーティリティー画
面を開いたあと、画面左の[Settings]タブ →
[MIDI I/O]タブをタッチします。

3「FS Assign」を「Live Set ＋」または
「Live Set -」に設定します。
フットスイッチを踏むと「Live Set ＋」では順方向
にパフォーマンスが切り替わり、「Live Set -」では逆
方向にパフォーマンスが切り替わるようになります。
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MODXでは、編集画面からパートやパフォーマンス、エフェクト、アルペジオなど、さまざまな設定を編集(エディット)する
ことができます。ここではパートを組み合わせてパフォーマンスを作る手順についても説明します。

パフォーマンスをエディットする
パフォーマンス全体に関するさまざまな設定項目(パラメー
ター )を編集する操作をパフォーマンスエディットといい、
パフォーマンスエディット画面で行ないます。

パフォーマンスをエディットする基本手順

1 パフォーマンスプレイ画面でカーソルをパフォー
マンスネームに合わせ、[EDIT]ボタンを押しま
す。

2 画面左の[General]タブをタッチして、パフォー
マンスエディットを行ないます。

パフォーマンスエディット画面 

パフォーマンスの保存(ストア)

エディット作業が終わったら、作成したパフォーマンスを本
体メモリーに保存します。このように、本体のメモリーに保
存することをストアといいます。
[STORE]ボタンを押して、パフォーマンスを保存しましょ
う。

注記
• 保存(ストア)をせずに別のパフォーマンスを選んだり電源を切ったり
すると、エディットの内容は消えてしまいます。

• ユーザーバンクにあるストア先のパフォーマンスは、上書きされると
消えてしまいます。エディットしたパフォーマンスを保存する場合は、
大事なユーザーパフォーマンスに上書き保存しないようにご注意くだ
さい。大切なデータは、あらかじめUSBフラッシュメモリーに保存
(セーブ)しておくことを、おすすめします。セーブの操作については
60ページをご参照ください。

NOTE
パフォーマンスエディット中に[PART SELECT MUTE/SOLO](パート
セレクト ミュート/ソロ)ボタンによりパートを選択すると、パートエ
ディットに切り替わります。

1 [STORE]ボタンを押してストア画面を表示しま
す。

2 パフォーマンスの保存先を設定します。
新規にパフォーマンスを保存する場合は[Store As 
New Performance]の「＋」をタッチします。

NOTE
すでに保存されているパフォーマンスを上書きする場合は、
[Overwrite Current Perf.]をタッチするか、対象のパフォーマンス
をタッチします。

3 文字入力画面が表示され、保存するパフォーマン
スの名前を設定します。
名前の設定方法について詳しくは、「基本操作と画面表
示」の「文字入力」(21ページ)をご参照ください。

4 文字入力画面の「Done」を選択すると、ストア
が実行されます。
NOTE
すでに保存されているパフォーマンスを上書きする場合は、手順2の
あとに実行確認の画面が表示されるので、「YES」を選択するとスト
アが実行されます。

編集(エディット)する

パフォーマンスを新規保存

すでに保存されているパフォーマンス
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パートをエディットする
パートを構成するさまざまな設定項目(パラメーター )の値を
変更してパートを作り変える操作をパートエディットとい
い、エレメントコモン/キーコモン/オペレーターコモンエ
ディット画面とエレメント/キー /オペレーターエディット
画面で行ないます。パートエディットは、パートの種類に
よってパラメーターが異なります。

ノーマルパート(AWM2)エディット

鍵盤の音階どおりに発音する「ノーマルパート(AWM2)」
は、最大8個のエレメントで構成されています。エレメント
とは、パートを構成する最小単位です。ノーマルパート
(AWM2)のエディットは、8つのエレメントに共通のパラ
メーターを設定する「エレメントコモンエディット」と、
エレメントごとのパラメーターを設定する「エレメント
エディット」の2種類に分かれます。

ノーマルパート(FM-X)エディット

FM-X音源による音色が割り当てられた「ノーマルパート
(FM-X)」は、最大8個のオペレーターで構成されています。
ノーマルパート(FM-X)のエディットは、8つのオペレー
ターに共通のパラメーターを設定する「オペレーターコモン
エディット」と、オペレーターごとのパラメーターを設定す
る「オペレーターエディット」の2種類に分かれます。

ドラムパートエディット

各鍵盤にいろいろな打楽器が割り当てられた「ドラムパー
ト」のエディットは、全キーに共通のパラメーターを設定す
る「キーコモンエディット」と、キーごとのパラメーターを
設定する「キーエディット」の2種類に分かれます。

パートをエディットする基本手順

1 パフォーマンスプレイ画面でカーソルをエディット
したいパートに合わせ、[EDIT]ボタンを押します。
[PART SELECT MUTE/SOLO]ボタンからも選べま
す。

2 画面左の[Part Settings]タブ → [General]タ
ブをタッチして、パートエディットを行ないます。

● ノーマルパート(AWM2)を選択している場合
エレメントコモンエディットを行なうには、エレメント
[Common]タブにタッチします。
エレメントエディットを行なうには、[Elem1]～
[Elem8]タブのうち、エディットしたいエレメントのナ
ンバータブを押します。

● ドラムパートを選択している場合
キーコモンエディットを行なうには、ドラムキー
[Common]タブにタッチします。
キーエディットを行なうには、 [BD]～[Crash]タブのう
ち、エディットしたいドラムパーツ(BD、SDなど)のナ
ンバータブを押します。
[Drum Key]タブにタッチしてから[BD]～[Crash]タブ
を切り替えることで、C1～C♯2の鍵盤にアサインされ
ているキーを選択できます。それ以外の鍵盤にアサイン
されているキーを選択するには画面の「Keyboard 
Select」をオンにし、エディットしたいキーがアサイ
ンされている鍵盤を押します。

● ノーマルパート(FM-X)を選択している場合
オペレーターコモンエディットを行なうには、オペレー
ター [Common]タブにタッチします。
オペレーターエディットを行なうには、 [OP1]～[OP8]
タブのうち、エディットしたいオペレーターのナンバー
タブを押します。

NOTE
パートパラメーターについて詳しくは、PDFファイル「リファレン
スマニュアル」のパート説明箇所をご参照ください。

エレメントは、楽器音などの波形(ウェーブ)にさまざまな
パラメーター (エフェクト、EGなど)を付加して作られて
います。MODXのノーマルパート(AWM2)は、エレメン
トを最大8個組み合わせることによって作られています。

FM-X音源の「FM」とは「Frequency Modulation」
(フリケンシーモジュレーション)のことで、周波数を変調
するという意味です。音のもととなる波形の周波数を別の
波形を使って変調させることで、新しい波形を作りだす方
式です。波形を発生させる装置は「オペレーター」と呼
び、MODXではオペレーターを8つ使います。変調され
る側のオペレーターを「キャリア」、変調する側のオペ
レーターを「モジュレーター」と呼び、8つのオペレー
ターはキャリアとモジュレーターのどちらにも使うことが
できます。オペレーターの組み合わせを変えたり、さらに
レベルやエンベロープなどの他の要素を調整することで、
音に複雑な変化を与えることができます。

キャリア

モジュレーター

変調される波形 変調した波形

変調させる波形

音の出口

モジュレーターの音量が上がると、
キャリアの波形が変化する。
※音量が0だと、キャリアの波形は
変化なし。

キーには、ドラムやパーカッションの楽器音が割り当てら
れています。割り当てる楽器音の種類を変えたり、ピッチ
やEQを調節することで、さまざまなドラムパートを作成
できます。
MODXのドラムパートは、キーを最大73個組み合わせる
ことによって作られています。
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編集(エディット)する

● エレメントコモンエディット画面 

画面構成はキー /オペレーターコモンエディット画面も
同様です。

● エレメントエディット画面 

画面構成はキー /オペレーターエディット画面も同様で
す。

3 必要に応じてパフォーマンスを保存します。

パートのエフェクトをエディットする
MODXには数多くのエフェクトが内蔵されています。この
エフェクトを活用することで、パートにさまざまな効果をか
けられます。プリセットパートのエフェクトを変更するだけ
でも、まったく違ったパートに仕上げることができます。こ
こではパートにかけるエフェクトタイプや設定を変更し、
ユーザーパフォーマンスとして保存する手順を説明します。

1 パフォーマンスプレイ画面でカーソルをエディッ
トしたいパートに合わせ、[EDIT]ボタンを押しま
す。

2 エレメント[Common]タブをタッチします。

3 画面左の[Effect]タブ → [Routing]タブをタッ
チします。
エレメントコモンエディットのエフェクト画面が表示さ
れます。 

1 各エレメント/キーの出力先

2 インサーションエフェクトAのカテゴリー

3 インサーションエフェクトAのタイプ

4 インサーションエフェクトAのプリセット

5 インサーションエフェクトAとBの接続方法

6 サイドチェーン/モジュレーターパートの選択

4 各エレメント/キーの出力先(1)を設定します。

5 インサーションエフェクトAのエフェクトカテゴ
リー (2)とエフェクトタイプ(3)、エフェクトプ
リセット(4)を選びます。

6 インサーションエフェクトAとBの接続方法(5)を
設定します。

7 インサーションエフェクトBのサイドチェーン/
モジュレーター (6)を設定します。
NOTE
サイドチェーン/モジュレーターとは、通常の入力とは別系統の入力
のことです。特定のエフェクトタイプでこれらを指定することがで
き、MODXでは選択中のパートと異なるパートやオーディオの入力
信号により、エフェクトのかかり具合をコントロールできます。
エフェクトタイプによりサイドチェーン、モジュレーターと呼び方
が異なります。

エレメントコモンエディット画面であることを示しています。

エレメントコモンエディットとエレメントエディットを切り替え

エレメントエディット画面であることを示しています。 2 31

5

4

6
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編集(エディット)する

8 画面左内側の[Ins A]タブをタッチします。
手順4で選択されたエフェクトパラメーターを細かく設
定できる画面が表示されます。

9 必要に応じて各パラメーターを設定します。
エフェクトによってさまざまなパラメーターが用意され
ていますので、イメージに近い音になるまで微調整をし
ましょう。

10 同様にインサーションエフェクトBもエディット
します。

11 必要に応じてパフォーマンスを保存します。

パフォーマンスのパート構成例
パフォーマンスを選んで演奏してみると、アルペジオが鳴り
出すものや、鍵盤の位置によって別の音が鳴るもの、いくつ
もの音が重なって鳴るものなど、さまざまな種類のものがあ
ります。中には、どう演奏していいのか分からないようなも
のもあるかもしれません。そういう場合には、そのパフォー
マンスのパートの組み合わせ方を理解すると活用方法が見え
てきます。ここでは、基本となる4種類のパートの組み合わ
せ方をご紹介します。

1つの鍵盤を押さえることで、2つ以上のパートが同時に鳴
るようにする方法です。
たとえば、立ち上がりの早さの違う数種類のストリングをレ
イヤーさせて音に厚みを出したり、ピアノ系のパートとパッ
ド系のパッドをレイヤーさせたりなど、多彩なパフォーマン
スを作成できます。

鍵盤の位置(音域)によって、別のパートが鳴るようにする方
法です。
たとえば、低音域にストリングス、高音域にフルートを割り
当てておくと、左手でストリングスを演奏しながら右手でフ
ルートを弾くなど、1人で同時に複数の音色を演奏すること
が可能になります。

コンペア機能
エディットした音色をエディット前の音色に一時的に
切り替えることができる機能で、エディットによって
どう音が変わったか聞き比べることができます。

エディット画面を表示した状態で、[EDIT]ボタンを押
します。[EDIT]ボタンが点滅し、エディット前の状態
に一時的に戻ります。[EDIT]ボタンをもう一度押す
と、エディット後の状態に戻ります。

パフォーマンスの構成1 レイヤー

パフォーマンスの構成2 スプリット

C1 C2 C3 C4 C5 C6

立ち上がりの早いストリングス

立ち上がりの遅いストリングス パート1

パート2

C1 C2 C3 C4 C5 C6

フルートストリングス

パート1 パート2
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複数のパートを重ね、鍵盤を弾く強さ(ベロシティー )で別の
パートが鳴るようにする方法です。
たとえば、弱いベロシティーではゆっくりと立ち上がる柔ら
かいストリングが、中ぐらいのベロシティーでは立ち上がり
が早いストリングが、強いベロシティーではオーケストラ
ヒット系の迫力あるストリングス音が、それぞれ鳴るように
設定しておくと、鍵盤を弾く強さによって多彩な演奏が実現
できます。

アルペジオを利用して、1人でバンドアンサンブルを実現す
る方法です。
MODXでは、パフォーマンスを構成する8つのパートに対
して、別々のアルペジオを同時に割り当てられます。そこ
で、別のアルペジオを割り当てた4種類のパートをレイヤー
することで、4種類の楽器が異なったパートを演奏している
アンサンブル演奏が実現できます。
たとえば、ドラム、ベース、ギター、ピアノを下記のように
配置し、それぞれの楽器に合ったアルペジオを設定しておき
ます。すると、低音域の鍵盤を押さえるとベースのリズム、
高音域の鍵盤を押さえるとピアノとギターのコードバッキン
グ、鍵盤すべての音域でドラムの音が演奏されます。する
と、曲のコード進行に合った鍵盤を押さえるだけで、その曲
の伴奏パートが完成します。さらに、画面上のMotion 
Control → Arpeggioでアルペジオの種類を切り替えると、
イントロからAメロ、サビ、エンディングまで、バリエー
ションに富んだ演奏も可能です。

パフォーマンスについて、基本的な4種類の構成をご紹介し
ましたが、この4つを組み合わせることでさらに多彩な
パフォーマンスを作成できます。いろいろなパフォーマンス
を試して、どのような組み合わせ方が用いられているか確認
してみましょう。それぞれのパフォーマンスについて、
パフォーマンスの構成を探り出し、演奏方法や活用方法を見
つけ出してみてください。

パートを組み合わせてパフォーマンス
を作る
例として2つのパートを組み合わせてパフォーマンスを作る
方法を説明します。

パフォーマンスを選ぶ

パート1にピアノ音色を割り当てましょう。

1 パフォーマンスプレイ画面でカーソルをパート1
のパートネームに合わせ、[SHIFT]ボタンを押し
たまま[CATEGORY]ボタンを押します。
パートカテゴリーサーチ画面が表示されます。

2 パフォーマンスリストから[Full Concert 
Grand]を選びます。

3 [EXIT]ボタンを押します。

パートを重ねる(レイヤー )

パート2に好きな音色を割り当てて、パート1とパート2の
2つの音色を重ねて発音させてみましょう。

1 パフォーマンスプレイ画面でパート2のパート
ネームにカーソルを移動し、[SHIFT]ボタンを押
したまま[CATEGORY]ボタンを押して好きな音
色を選びます。

2 鍵盤を弾いてみましょう。
パート1のピアノ音色と、パート2の自分で割り当てた
音色が重なって発音されます。

3 [EXIT]ボタンを押します。

次は、音色ごとに鍵盤の領域を分けてみましょう。

パフォーマンスの構成3 ベロシティースプリット

パフォーマンスの構成4 アルペジオ

C1 C2 C3 C4 C5 C6

立ち上がりの早いストリングス

ゆっくりした立ち上がりの柔らかいストリングス パート1

パート2

オーケストラヒット パート3

弾く強さ

弱

中
強

強

C1 C2 C3 C4 C5 C6

ピアノ(アルペジオ)

ドラム(アルペジオ<ホールド=オン>) パート1

パート4パート2

ギター(アルペジオ)

ベース(アルペジオ)

パート3



MODX 取扱説明書42

編集(エディット)する

鍵盤の領域を分ける(スプリット)

パート1の音色を低音域の鍵盤に割り当て、パート2の音色
を高音域の鍵盤に割り当てて、異なった音色を同時に演奏し
てみましょう。

1 ノートリミット ロー (パートの発音鍵域の最低音)

2 ノートリミット ハイ(パートの発音鍵域の最高音)

1 パート1のノートリミット ハイ(2)をタッチ、
もしくはカーソルを移動し[ENTER]ボタンを押
します。

2 画面左の[Keyboard]メニューをタッチし、オン
に切り替えます。

3 鍵盤を押し、パート1の最高音を設定します。
パート1のRange欄のキーナンバーと目盛りが発音域に
合わせて変わります。

4 パート2のノートリミット ロー (1)をタッチ、
もしくはカーソルを移動し[ENTER]ボタンを押
します。

5 鍵盤を押し、パート2の最低音を設定します。
パート2のRange欄のキーナンバーと目盛りが発音域に
合わせて変わります。

6 画面左の[Keyboard]メニューをタッチし、オフ
に切り替えます。

7 鍵盤を弾いてみましょう。
左手でパート1のピアノ音色、右手でパート2の自分で
割り当てた音色を弾いてみましょう。

8 スライダーファンクション[PART]/
[ELEMENT/OPERATOR]ボタンで「PART」
を選びます。

9 コントロールスライダー1と2を使って、パート
1とパート2の音量を調整します。

スプリット時に片方のパートのピッチを
1オクターブ下げる

パート2のピッチを1オクターブ下げて演奏してみましょう。

1 カーソルをパート2に合わせ、[EDIT]ボタンを
押して、パートエディットに入ります。

2 画面左の[Part Settings]タブ → [Pitch]タブ
をタッチします。

3「Note Shift (ノートシフト)」を選択し、ピッチ
を調整します。
半音単位でピッチを調整できます。1オクターブ下げる
ためには「-12」と設定します。

4 鍵盤を弾いてみましょう。

アルペジオの設定を変更する

パフォーマンスのアルペジオの設定を変更してみましょう。
演奏したい曲のジャンルに合ったリズムやバッキングパター
ンを選びましょう。

1 カーソルをパート1に合わせ、[EDIT]ボタンを
押して、エレメントコモンエディット画面を開き
ます。

2 画面左の[Arpeggio]タブ → [Common]タブを
タッチします。
すべてのアルペジオタイプに共通なアルペジオ設定をす
る画面が表示されます。
この中に「Hold」(ホールド)というパラメーターがあり
ます。これは、「On」に設定すると鍵盤から指を離して
もアルペジオが鳴り続ける設定です。ドラムやパーカッ
ションによるリズム演奏など、鳴らし続けたいパートは
「On」に設定しておくと便利です。

12

パート1： ピアノ パート2: 自分で割り当てた音色

ノートシフト
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編集(エディット)する

3 [Individual]タブをタッチし、アルペジオタイプ
ごとの設定画面を開きます。

4 アルペジオタイプをタッチし、画面左の
[Category Search]メニューを選択します。
([CATEGORY]ボタンを押すことでも同様の操
作ができます。）
カテゴリーでは楽器の種類を、サブカテゴリーでは音楽
ジャンルの種類を選ぶ、という手順でアルペジオを選び
ます。タイプには、AメロやBメロ、サビ、ブリッジな
ど、曲の各部を構成するバリエーションが含まれている
ので、鍵盤を押さえて、アルペジオを再生しながら選び
ましょう。

1つのアルペジオタイプの設定が終わったら、他のアル
ペジオタイプも設定しましょう。

5 必要に応じてパフォーマンスを保存します。

リズムパターンを使う
[RHYTHM PATTERN](リズムパターン)ボタンを使う
と、現在のパフォーマンスにリズムパートを簡単に追加
することができます。
また、リズムパターンとエンベロープフォロワーを組み
合わせることで、さらに音色を変化させることができま
す。

ここでは、「Supertrance」というパフォーマンスに
「8Z Trans Basics 1」というリズムパターンを追加
し、エンベロープフォロワーを使って音色を変化させる
例を説明します。

リズムパートを簡単に追加する

1 リズムパートを追加したいパフォーマンスを選び
ます。
ここでは「Supertrance」を選びます。

2 [RHYTHM PATTERN](リズムパターン)ボタ
ンを押します。
リズムパターン画面が表示されます。
パート1～8のすべてのパートが使用中の場合は、「Part 
Full」と表示され、リズムパターンは追加できません。

1 バンク/フェーバリット

2 ネームサーチ

3 キット選択

4 ミュート

5 ソート

6 ページ切り替え

3 リズムパターンリストから使いたいリズムパター
ンのキットをタッチします。
ここでは「8Z Trans Basics 1」 をタッチします。
リズムパートが追加されます。

4 鍵盤を弾くとリズムが鳴ります。

[Common]タブ

アルペジオタイプの設定

3

4

1 2

5 6
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編集(エディット)する

5 [PERFORMANCE (HOME)]ボタンまたは
［EXIT]ボタンを押して、リズムパターンを確定し
ます。
リズムパターン画面が閉じます。

NOTE
HOMEアイコンをタッチしても確定させることができます。

6 リズムパターンを止めるには、[ARP ON/OFF]ボ
タンまたは[J](ストップ)ボタンを押します。

NOTE
画面上の[Arp Hold On]ボタンをタッチしてもリズムパターンを止
められます。

エンベロープフォロワーを設定する

エンベロープフォロワーとは、入力信号の波形のエンベロー
プ(振幅包絡)を抽出する機能のことで、音色を変化させるコ
ントローラーとして使います。たとえば、リズムパターンを
割り当てたパートのエンベロープフォロワーを「ソース
(Source)」として使い、他のパートの音色を変化させると
いうようなことができます。たとえば、ある特定の音色が鳴
る間に別の音色の音量を下げる場合(ダッキング)などに使う
と便利です。

1 リズムパターン画面下の[Envelope Follower]
タブをタッチします。
エンベロープフォロワー画面が表示されます。

2 エンベロープフォロワースイッチをオンにします。
ここで鍵盤を弾くとエンベロープフォロワーの効果を確
認できます。

3 必要に応じて、設定を調節します。
ここでは、カーブボラリティー (Polarity)を 「Bi」、
カーブレシオ(Ratio)を 「-63」、ゲイン(Gain)を
「-12dB」などにします。

よりこまかい調節をしたい場合には画面の[Edit]ボタン
をタッチして、エンベロープフォロワーの設定画面を開
きます。

リズムパターンのキットやアルペジオタイプをを選びなおし
たいときは、[RHYTHM PATTERN]ボタンを押してリズム
パターン画面に戻ります。キットやアルペジオタイプを選び
なおしても、エンベロープフォロワーの設定は保持されま
す。
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MODXでは、本体に「ソング」としてMIDIデータの録音ができ、USBフラッシュメモリーを接続すればMODX本体の演奏を
USBフラッシュメモリーにオーディオ録音することもできます。

用語を理解しましょう

ソング
ソングは、鍵盤やコントローラーによる演奏をMIDIイベン
トとして各トラックに録音した、MIDIシーケンサーデータ
です。MODXには最大で128曲保存することができます。

トラック
トラックとは、演奏を録音するためのメモリーのことで、
1つのトラックには1パート分の楽器の演奏が録音できま
す。MODXのソングには、16トラックが用意されていて、
16パート分の演奏を録音/再生可能です。

リアルタイム録音
メトロノームに合わせて実際に鍵盤やコントローラーを演奏
してデータを入力する方法です。リアルタイム録音には、
Replace (リプレース)、Overdub (オーバーダブ)、Punch 
(パンチ)の3つの方法があります。
• Replace: 元のデータを消して上書き録音します。
• Overdub: 元のデータを残したまま重ね録音します。
• Punch: 元のデータの指定した範囲を部分的に上書き録音
します。

MIDI録音する
MODXには、曲を作るためのパフォーマンスレコーダー (簡
易シーケンサー )が内蔵されています。シーケンサーとは、
楽器の演奏を演奏データ(MIDIデータ)として記録する機能
のことです。思いついたフレーズをMODXに録音し、DAW
で仕上げればビッグバンドやオーケストラの演奏なども1人
で作り上げることができます。

トラックに録音する

ここからは、実際に曲を入力しながら操作を体験してみま
しょう。ますば、トラック1にメロディーを録音します。
では、録音の準備からはじめましょう。

1 パフォーマンスプレイ画面で画面左の[Play/
Rec]タブをタッチします。
レコーディング画面が表示されます。

2 画面左内側の[MIDI]タブをタッチします。

3 [I](レコード)ボタンを押します。
レコードセットアップ画面が表示されます。

NOTE
パフォーマンス画面で[●](レコード)ボタンを押すことで1～3の手
順を一度にまとめて操作できます。

1 ソングネーム

2 選択中のパフォーマンスネーム

3 拍子

4 ポジション(再生/録音開始位置)

5 クオンタイズ

6 シーケンス全体に対するポジションを表示

7 シーケンス全体の時間

8 トラックごとの再生オン/オフ切り替え

9 テンポセッティング画面へのショートカット

) テンポ変更

4 レコードセットアップ画面で、下記の設定を行な
います。

4-1.「Time Signature (拍子)」(3)にカーソルを移動し、
作成する曲の拍子を設定します。ここでは「4/4」に
設定します。

4-2.「Rec Quantize (クオンタイズ)」(5)で「240(♪)」
に設定します。クオンタイズとは、正確に弾いている
つもりでも、タイミングが微妙に遅れたり早かったり
するズレを補正し、タイミングをジャストにそろえる
機能です。ここでは、演奏するソングに出てくる最も
短い音符の長さを設定します。

5 入力の準備ができたら、[R](プレイ)ボタンを押
してリアルタイム録音をスタートします。
[R](プレイ)ボタンを押すとプリカウントが鳴るので、
その後演奏を開始してください。

6 最後まで録音できたら、[J](ストップ)ボタンを
押して、録音をストップします。
間違ってしまったら、[J](ストップ)ボタンを押して録
音をストップし、もう一度初めから録音しなおしましょ
う。何度でも弾き直せるので、うまく演奏できるまでト
ライしてください。

録音/再生する

1

3

4

)

7

9

5

6

8

2
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録音/再生する

クリックを聞きながら録音する
以下の手順で、MIDI録音時にクリック音を鳴らすこと
ができます。

1 [UTILITY] → [Tempo Settings] (またはそ
の他の画面内のClick Settingsボタン)でテン
ポ設定画面を開き、クリックの「Mode」を
「Rec」に設定します。

NOTE
「Mode」を「Rec/Play」に設定するとMIDI録音/再生時にクリッ
ク音が鳴ります。「Always」に設定すると常にクリック音が鳴る
状態になります。

部分的に録音をやり直す(パンチイン/アウト録音)
一度録音したトラックを部分的に録音し直す方法とし
て、パンチイン/アウト録音があります。録音をスター
トすると再生が始まり、パンチインの小節で自動的に
録音状態に入り、パンチアウトの小節で自動的に再生
状態に戻ります。たとえば、8小節のソングの中で3小
節～5小節の間を録音し直したい場合は以下のように
なります。

NOTE
パンチイン/アウト録音はリプレース録音方式になります。

上図のパンチイン/パンチアウト録音を実行するには、
レコードセットアップ画面であらかじめ以下のパラ
メーターを設定します。

1 レコードタイプ「Record Type」=「Punch」

2 パンチイン(再録音開始小節：拍) = 003:01
この小節：拍から該当トラックの再生音が消え、
鍵盤演奏が録音されます。

1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8

再録音前

再録音後

新しい録音データ

録音スタート

パンチイン

録音ストップ

パンチアウト

3 パンチアウト(再録音終了小節：拍) = 006:01
この小節：拍から通常再生に戻ります。

直前に実行した録音を取り消す(アンドゥー /リドゥー )
アンドゥーは、直前に実行した録音を取り消して、実
行前の状態に戻します。リドゥーは、アンドゥーで取
り消した操作を再び実行します。

1 アンドゥー (何も録音していない状態では表示され
ません。)
タッチすると実行を確認するダイアログ画面が表
示されます。実行を選択すると直前に実行した録
音を取り消して、実行前の状態に戻します。

2 リドゥー (アンドゥーしていない状態では表示され
ません。)
タッチすると実行を確認するダイアログ画面が表
示されます。実行を選択するとアンドゥー実行前
の状態に戻します。

2 31

1

2
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録音/再生する

ソングを再生する
録音したソングを再生しながら、トラックのミュート/ソロ
やコントロールスライダーの活用方法についてご紹介しま
す。
ソングの再生をスタートさせ、実際に音で確認しながら操作
してみましょう。

ソングの再生

1 [R](プレイ)ボタンを押して、ソングの再生を始
めます。

NOTE
音の大きさを[MASTER VOLUME]ノブで調節してください。

2 [J](ストップ)ボタンを押して、ソングの再生を
止めます。

各パートのボリュームを操作する

コントロールスライダーを操作すると、パート1～4の
ボリュームを操作できます。

[PART]/[ELEMENT/OPERATOR]ボタンを押してPART
ランプを点灯させてからスライダーセレクト[1-4]/[5-8]ボ
タンを押すと、パート5～8のボリュームが操作できる状態
になります。

この他に、ノブ1～4 (5～8)にも、演奏中のソングのパー
トの設定を、リアルタイムに操作できるさまざまな機能が割
り当てられています。詳しくは、リファレンスマニュアルを
ご参照ください。

オーディオ録音する
MODX本体での演奏をUSBフラッシュメモリーに、WAV
形式(44.1kHz/24bit/ステレオ)のオーディオファイルとし
て録音できます。録音時の録音レベルは固定されており、連
続で最大74分または録音先デバイスの上限の容量まで録音
ができます。

注記
オーディオファイルの録音/再生/保存中は、MODXの電源を絶対に切ら
ないでください。録音/保存先のUSBフラッシュメモリーに正常にアク
セスできなくなるおそれがあります。

1 USBフラッシュメモリーをMODXの[USB TO 
DEVICE]端子に接続します。

2 パフォーマンスプレイ画面で画面左の[Play/
Rec]タブをタッチします。
レコーディング画面が表示されます。

3 画面左内側の[Audio]タブをタッチします。

4 [I](レコード)ボタンを押して、オーディオレコー
ドに入ります。
レコードセットアップ画面が表示されます。

1 ポジション(再生位置)

2 オーディオ全体の長さと現在の再生位置を表示

3 録音可能時間

4 レベルメーター

5 トリガーレベルの設定値

5 トリガーレベルを(5)設定します。
「Trigger Level」=「manual」に設定した場合は、
[R](プレイ)ボタンを押すことで録音を開始します。
「TriggerLevel」=「1～127」に設定した場合は、設
定した値を超える信号が入ってきたときに、録音が自動
的に開始されます。設定したレベルは、レベルメーター
(4)に青い三角形で表示されます。ノイズに影響されな
い範囲でできるだけ低く設定すると、アタック部分が切
れずに録音できます。

ストップ プレイ

2

4

3

5

1
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6 [R](プレイ)ボタンを押します。
「Trigger Level」=「manual」に設定した場合は、
[R](プレイ)ボタンを押すと[I](レコード)ボタンが赤色
に、[R](プレイ)ボタンが緑色にそれぞれ点灯し、録音
が開始されます。
「Trigger Level」=「1～127」に設定した場合は、設
定した値を超える信号が入るまで録音待機状態になりま
す。

7 鍵盤を演奏します。
「Trigger Level」=「1～127」に設定した場合は、設
定した値を超える信号が入ってきたときに、録音が開始
されます。

8 演奏が終わったら[J](ストップ)ボタンを押します。
録音先デバイスにオーディオファイルが保存されます。

オーディオファイルの再生
本体または本体以外の機器で作成した、USBフラッシュメ
モリー上のオーディオデータ(Waveファイル)は、以下の手
順により本体で再生できます。

1 USBフラッシュメモリーをMODXの[USB TO 
DEVICE]端子に接続します。

2 パフォーマンス画面で、画面左の[Play/Rec]タ
ブ → [Audio]をタッチします。

3「Audio Name」をタッチし、画面左の[Load]
メニューを選択します。

4 ロード元のUSBフラッシュメモリー、フォルダー
を選択します。

5 USBフラッシュメモリー内のファイル(拡張子: 
.wav)を選択して、ロードを実行します。

1 オーディオネーム

2 オーディオボリューム(再生音量)

3 オーディオの長さ

6 [R](プレイ)ボタンを押します。
オーディオファイルの再生が始まります。

7「Audio Volume」(2)にカーソルを合わせ、
データダイアルで再生音量を調節します。

8 [J](ストップ)ボタンを押して再生を停止します。
NOTE
オーディオファイルを再生させながら、選択中のパフォーマンスの
音色を演奏することができます。

2

3

1
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1

MODXでは 1つのパフォーマンスにつき8ゾーンのマスターキーボード機能を設定することができます。
ライブセットと組み合わせることで、外部MIDI機器をコントロールするための設定を瞬時に切り替えできるので、たとえば
ライブステージでパフォーマンスを演奏しながら、多数の外部MIDI音源を次々に切り替えて演奏する、といったことが可能に
なります。

マスターキーボード(ゾーン)機能の
設定をする
外部MIDI音源を複数使用するときは、マスターキーボード
(ゾーン)機能を設定してパフォーマンスに保存しておくと便
利です。パフォーマンスを切り替えると同時に、外部MIDI
音源のプログラムを変更することもできます。
基本的な操作手順は以下のとおりです。

はじめにMODX全体のマスターキーボード(ゾーン)設定を
有効にします。

1 [UTILITY]ボタンを押してユーティリティー画面
を開きます。

2 画面左の[Settings]タブ → [Advanced]タブ
をタッチします。

3 [Zone Master]ボタンをタッチし、オンにしま
す。

4 [EXIT]ボタンを押します。
元の画面に戻り、設定が保存されます。

次にパフォーマンスごとのマスターキーボード(ゾーン)設定
をします。

1 [PERFORMANCE (HOME)]ボタンを押してパ
フォーマンスプレイ画面を開きます。

2 選択中のパフォーマンスの任意のパートにカーソ
ルを合わせ、[EDIT]ボタンを押して、パートエ
ディットに入ります。

3 画面左の[Part Settings]タブ → [Zone 
Settings]タブをタッチします。

4 [Zone]ボタンをタッチして、オンにします。

5 送信チャンネルやノートリミットなど、ゾーンに
関する設定を行ないます。

6 続いて[Zone Transmit]タブをタッチして、
送信スイッチの設定を行ないます。

これらの設定が終わったら、[STORE]ボタンを押して
パフォーマンスを保存してください。

ゾーン設定について詳しくは、リファレンスマニュアルをご
参照ください。

マスターキーボードとして使う
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A/D INPUT [L/MONO]/[R]端子
からの入力信号を鳴らしながら演奏
する
MODXでは、A/D INPUT [L/MONO]/[R]端子にマイク
や、CDプレーヤーなどのオーディオ機器、シンセサイザー
などの電子楽器を接続し、入力音声をオーディオ入力パート
(A/Dインプットパート)として鳴らすことができます。ボ
リューム、パン、エフェクトなどの設定をし、他パートと
ミックスした上で、本体サウンドとして出力されます。

1 本体の電源がオフになっていること、およびA/D 
INPUT [GAIN] (ゲイン)ノブが最小になってい
ることを確認します。

2 本体リアパネルのA/D INPUT [L/MONO]/[R]
端子へ、外部機器の端子を差し込みます。

NOTE
マイクは、ダイナミックマイクをご使用ください。コンデンサーマ
イクは使用できませんので、ご注意ください。

3 接続した機器の電源をオンにしたあと、本体の電
源をオンにします。

4 [UTILITY]ボタンを押してユーティリティー画面
を開いたあと、画面左の [Settings]タブ → 
[Audio I/O]タブをタッチします。

5 A/D INPUT [L/MONO]/[R]端子に接続した機
器に従って「Mic」/「Line」を設定します。
マイクなどの出力レベルの低い機器を接続した場合は
「Mic」(マイク)に、オーディオ機器、電子楽器などの出
力レベルの高い機器を接続した場合は「Line」(ライン)
に設定します。

6 A/D INPUT [ON/OFF]ボタンを押して、ボタ
ンを点灯させます。
接続されたオーディオ機器からの入力信号が有効になり
ます。

7 接続した外部機器の音を聞きながら[GAIN]ノブ
を回して入力レベルを調節します。

8 [PERFORMANCE (HOME)] ボタンを押して、
接続した外部機器と一緒に使うパフォーマンスを
選択します。
マイクで歌ったり、オーディオ機器を再生させながら、
鍵盤を演奏してみましょう。

マイクやオーディオ機器を活用する

A/D INPUT
[R]端子

A/D INPUT
[L /MONO]端子

L

R

ステレオオーディオ機器(CDプレイヤーなど)

A/D INPUT
[L/MONO]端子

マイク
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ユーティリティー画面では、本体のさまざまな設定ができます。なかでも[Settings]タブを選択した状態では、システム全体
に共通した設定を行ないます。ユーティリティー画面で変更された設定は、[EXIT]ボタンを押し、元の画面に戻るタイミング
で保存されます。ここでは、システム全体の設定のうち、よく使われる機能を紹介します。

電源を入れたときの状態を設定する
電源を入れたときに、表示される画面の設定を行ないます。
ライブセット画面かパフォーマンスプレイ画面のどちらかを
選択できます。

1 [UTILITY]ボタンを押してユーティリティー画面
を開いたあと、画面左の[Settings]タブ → 
[System]タブをタッチします。

2「Power on Mode」で「Live Set (ライブセッ
ト画面)」か「Perform (パフォーマンスプレイ
画面)」のどちらかを選択し、「Live Set」を選択
した場合はさらにスロット番号を選んで、電源を
入れたときに表示される画面を設定します。

3 [EXIT]ボタンを押します。
元の画面に戻り、設定が保存されます。

ボタンの半点灯状態を設定する
半点灯に対応したボタンのオン/オフの設定、または明るさ
の設定を行ないます。

1 [UTILITY]ボタンを押してユーティリティー画面
を開いたあと、画面左の[Settings]タブ → 
[System]タブをタッチします。

2「Half Glow」で「Off」「1/4」「1/2」のいず
れかを選択します。
「Off」は半点灯設定をオフにします。
「1/4」は点灯状態を1とした場合、半点灯状態の明るさ
をその1/4の明るさに設定します。ライブ会場などの暗
い場所ではこちらを設定してください。
「1/2」は点灯状態を1とした場合、半点灯状態の明るさ
をその半分の明るさに設定します。屋外など、半点灯状
態と消灯状態の見分けが難しい場合はこちらを設定して
ください。

3 [EXIT]ボタンを押します。

元の画面に戻り、設定が保存されます。

さまざまな機能のオン/オフを設定
する
ユーティリティー画面で[System]タブを選択した状態で
は、その他、以下の設定も行なえます。

アニメーションのオン/オフ設定

画面が切り替わるときのアニメーションのオン/オフ設定を
行ないます。

1 [UTILITY]ボタンを押してユーティリティー画面
を開いたあと、画面左の[Settings]タブ → 
[System]タブをタッチします。

2「Animation」で「ON」か「OFF」のどちらか
を選択し、アニメーションのオン/オフを設定しま
す。

3 [EXIT]ボタンを押します。
元の画面に戻り、設定が保存されます。

ブラー (ぼかし)効果のオン/オフ設定

画面を切り替えたときに直前の画面をぼかした状態で表示す
るブラ―効果のオン/オフ設定を行ないます。

1 [UTILITY]ボタンを押してユーティリティー画面
を開いたあと、画面左の[Settings]タブ → 
[System]タブをタッチします。

2「Blur」で「ON」か「OFF」のどちらかを選択
し、ブラー (ぼかし)効果のオン/オフを設定しま
す。

3 [EXIT]ボタンを押します。
元の画面に戻り、設定が保存されます。

本体のさまざまな設定をする
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本体のさまざまな設定をする

ビープ音のオン/オフ設定

画面操作時のビープ音のオン/オフ設定を行ないます。

1 [UTILITY]ボタンを押してユーティリティー画面
を開いたあと、画面左の[Settings]タブ → 
[System]タブをタッチします。

2「Beep」で「ON」か「OFF」のどちらかを選択
し、ビープ音のオン/オフを設定します。

3 [EXIT]ボタンを押します。
元の画面に戻り、設定が保存されます。

スーパーノブの点滅オン/オフ設定

初期設定ではスーパーノブはビートに同期して点滅します。
その機能のオン/オフ設定を行ないます。
オフにすると点灯したままの状態となります。

1 [UTILITY]ボタンを押してユーティリティー画面
を開いたあと、画面左の[Settings]タブ → 
[System]タブをタッチします。

2「Knob Flash」で「ON」か「OFF」のどちら
かを選択し、スーパーノブの点滅オン/オフを設定
します。

タッチパネルのキャリブレーション

タッチパネルのタッチ位置と本体動作のずれを感じた場合
は、必要に応じてタッチパネルのキャリブレーションを行
なってください。

1 [UTILITY]ボタンを押したまま、[PART 
SELECT MUTE/SOLO]ボタンを押します。
[Calibrate Touch Panel]ボタンが選択された状態の
ユーティリティー画面が開きます。

2 [ENTER]ボタンを押します。

3 表示された白い四角いマークをタッチし、タッチ
パネルの位置を調整します。
NOTE
[UTILITY] → [Settings] → [System]でシステム設定画面を開き、
「Calibrate Touch Panel」をタッチすることでも設定できます。

マスターチューンを変更する
ピアノなど、チューニングを変更できない他の楽器とアンサ
ンブルする場合に、MODXのチューニングを変更できます。

1 [UTILITY]ボタンを押してユーティリティー画面
を開いたあと、画面左の[Settings]タブ →　
[Sound]タブをタッチします。

2「Tune (チューン)」を選択し、データダイアルを
使って数値を変更します。
ここでは例として、440Hzを442Hzに変更します。
MODXでのチューニングのパラメーターはCent 
(セント、100セント=半音)という単位になっています
が、設定値の右側に目安として「Hz」についても表記さ
れるので、こちらを確認しながら設定を変更します。
データダイアルを回して「+8.0」に変更します。ただ
し、より正確にチューニングする場合には、チューナー
などを使って合わせてください。

3 [EXIT]ボタンを押します。
元の画面に戻り、設定が保存されます。

チューニング
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本体のさまざまな設定をする

ベロシティーカーブを変更する
鍵盤を弾く強さに対するベロシティーの出方を決める、ベロ
シティーカーブを設定します。本体画面に表示されるグラフ
イメージの横軸は鍵盤を弾く強さ、縦軸が鍵盤から出力され
るベロシティーを示しています。

1 [UTILITY]ボタンを押してユーティリティー画面
を開いたあと、画面左の[Settings]タブ → 
[Sound]タブをタッチします。

2「Velocity Curve (ベロシティーカーブ)」を選
択し、カーブを設定します。

3 [EXIT]ボタンを押します。
元の画面に戻り、設定が保存されます。

Normal 
(ノーマル)

鍵盤を弾く強さとベロシティーが比例
する、もっとも一般的なカーブです。

Soft (ソフト) 全体に大きなベロシティーが出やすい
カーブです。

Hard (ハード) 全体に大きなベロシティーが出にくい
カーブです。

Wide (ワイド) キータッチの弱い部分ではベロシティー
をおさえ、強い部分ではベロシティーを
出やすくしたカーブです。ダイナミック
レンジが広く感じられます。

Fixed 
(フィックス)

鍵盤を弾く強さに関わりなく、一定の
ベロシティーで音源を鳴らしたい場合
に使用します。

ベロシティーカーブをFixedに設定した場合
以下の「Fixed Velocity」で設定した値が、一定の
ベロシティー値となります。

ベロシティーカーブ

ベロシティー値を設定

ローカルコントロールのオン/オフ設定
ローカルコントロールオン/オフを設定します。ローカ
ルコントロールオフにすると、本体の鍵盤/コントロー
ラー部と音源部が内部的に切り離され、鍵盤を弾いて
も音が出なくなります。ただし、ここでの設定には関
係なく本体の演奏情報はMIDI出力され、MIDI入力され
たメッセージは本体音源部で処理されます。

1 [UTILITY]ボタンを押してユーティリティー画
面を開いたあと、画面左の[Settings]タブ→
[MIDI I/O]タブをタッチします。

 
2「Local Control」で「ON」か「OFF」のど
ちらかを選択し、ローカルコントロールのオン/
オフを設定します。

3 [EXIT]ボタンを押して、元の画面に戻ります。

ローカルコントロール
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市販のMIDIケーブルを使って、MODXのMIDI [IN]/[OUT]端子と外部MIDI機器のMIDI端子を接続します。MODXから外部
MIDI機器をコントロールしたり、外部MIDIキーボードやシーケンサーでMODXの音源を鳴らしたりすることができます。こ
こでは、用途別にいくつかの例をご紹介します。

NOTE 
MIDIデータの入出力として、MIDI端子と[USB TO HOST]端子を使うことができます。ただし、これら2つを同時に使ってMIDI送受信することはできま
せん。どの端子を使うかについては、[UTILITY]ボタン → [Settings]タブ →「MIDI I/O」で設定します。ここではMIDI端子を使って接続する例を紹介
しているので、その場合「MIDI IN/OUT」を「MIDI」に設定します。

外部MIDIキーボードやシンセサイ
ザーでMODXをコントロールする
場合
本体の鍵盤ではなく外部MIDIキーボードの鍵盤演奏で、本
体のパフォーマンスを鳴らしたりパフォーマンス変更などを
コントロールできます。

MODXで外部MIDIキーボードやシ
ンセサイザーをコントロールする場
合
本体の鍵盤演奏やソング再生で、他のMIDI音源(シンセサイ
ザー、音源モジュールなど)の音を鳴らすことができます。
本体の音色だけでなく、他の音源の音色も同時に鳴らしたい
場合の使いかたです。

外部MIDI機器と接続して使う

MIDI送信チャンネルと受信チャンネル
この接続で本体の音を鳴らすために、外部MIDIキー
ボードのMIDI送信チャンネルとMODX本体のMIDI受
信チャンネルを合わせる必要があります。外部MIDI
キーボードのMIDI送信チャンネルについては、外部
MIDIキーボードの取扱説明書でご確認ください。
MODX本体のMIDI受信チャンネルは、MIDI I/Oモー
ドがマルチの場合、パート1は1チャンネル、パート2
は2チャンネル、というようにパート番号とMIDI受信
チャンネル番号は同一です。MIDI I/Oモードがシング
ルの場合は、全パート同じチャンネルで受信します。

外部MIDIキーボード、シンセサイザーなど

MIDI [IN]端子

MIDI [OUT]端子

MODX

本体音源と外部音源の鳴らし分け
この接続により、本体の音と外部音源の音との鳴らし
分けができます。このとき、本体のMIDI送信チャンネ
ルと外部MIDI音源の受信チャンネルを合わせる必要が
あります。MODXのMIDI送信チャンネルは、受信チャ
ンネルと同様にパート1は1チャンネル、パート2は2
チャンネル、というようにパート番号とMIDI送信チャ
ンネル番号は同一ですが、以下の方法で任意のMIDI送
信チャンネルへ変更ができます。
[UTILITY] → [Advanced] →「Zone Master」を
オンにします。パートエディットに入り、[Part 
Settings] → [Zone Settings]でゾーン設定画面を開
き、「Zone Transmit」でMIDI送信チャンネルを確認
し、必要に応じて変更してください。外部音源の音だ
けを出したい場合は、MODX本体のボリュームを下げ
るか、[UTILITY] → [Settings] → [MIDI I/O]でMIDI
設定画面を開き、「Local Control」 (ローカルコント
ロール)を「OFF」に設定します。
外部MIDI音源の受信チャンネルの設定方法について
は、外部MIDI音源の取扱説明書をご参照ください。

MOTIF-RACK XSなどの外部MIDI音源

MIDI [OUT]端子

MIDI [IN]端子

MODX
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MODXとコンピューターを接続することで、DAWやシーケンサーなどの音楽制作用アプリケーションとMODXを組み合わせ
て音楽制作の幅を大きく広げることができます。

NOTE 
DAWとは、デジタルオーディオワークステーション(Digital Audio Workstation)の略で、オーディオの録音や編集、ミキシングなど一連の作業ができ
るアプリケーションソフトのことを指します。代表的なDAWソフトウェアとして、Steinberg Cubase、Ableton Live、Apple Logicなどがあります。

コンピューターとの接続準備
MODXをコンピューターと接続するためには、USBケーブ
ルとYamaha Steinberg USBドライバーが必要です。次
の手順で操作してください。送受信できるデータは、オー
ディオデータとMIDIデータの両方です。

1 以下のURLから、最新のYamaha Steinberg 
USBドライバーをダウンロードします。
ダウンロードボタンを押したあと、ファイルの実行およ
び解凍をします。

https://jp.yamaha.com/support/

NOTE
• 動作環境については、上記URLをご覧ください。
• Yamaha Steinberg USBドライバーは、改良のため予告なしに
バージョンアップすることがあります。詳細および最新情報につ
いては、上記URLをご確認ください。

2 Yamaha Steinberg USBドライバーをコン
ピューターにインストールします。
ダウンロードしたファイルに付属されているインストー
ルガイドをご参照ください。手順の中の、機器の[USB 
TO HOST]端子をUSBケーブルでコンピューターと接
続する箇所については、下図を参考にしてください。

3 [UTILITY]ボタンを押してユーティリティー画面
を開きます。

4 画面左の[Settings]タブ → [MIDI I/O]タブを
タッチします。

5「MIDI IN/OUT」を「USB」に設定します。
本体を、[USB TO HOST]端子を通してMIDIを送受信
する状態に切り替えます。

6 目的に合わせて、オーディオの入出力設定を行な
います。
[UTILITY] → [Settings] → [Audio I/O]で設定できま
す。
またクイックセットアップ機能を使って、オーディオと
MIDIに関する設定を保存しておくと、次回から簡単にそ
の設定を呼び出せて便利です。
画面左の[Quick Setup]タブをタッチし、クイックセッ
トアップ画面を開きます。
[Store Current Settings]をタッチすると、「Quick 
Setup」の1～3のいずれかに設定を保存できます。

NOTE
クイックセットアップで設定されるパラメーターについては、
リファレンスマニュアルをご参照ください。

コンピューターと接続して使う

[USB TO HOST]端子
USB端子

USBケーブル

本体リアパネル

クイックセットアップ1～3

https://jp.yamaha.com/support/
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コンピューターと接続して使う

[USB TO HOST]端子ご使用時の注意
USB TO HOST端子でコンピューターと接続するとき
は、コンピューターや本体の停止(ハングアップ)によ
るデータの損失を防ぐため、以下のことを行なってく
ださい。
注記

• USBケーブルはABタイプをお使いください。USB3.0
ケーブルは、ご使用できません。

• 本体の電源オン/オフやUSBケーブルの抜き差しをする
前に、以下のことを行なってください。

　- すべてのアプリケーションを終了させてください。
　- 本体からデータが送信されていないか確認してくださ
い。（鍵盤を演奏したりソングを再生させたりしても、
本体からデータが送信されます。）

• 本体の電源オン/オフやUSBケーブルの抜き差しは、
6秒以上間隔を空けて行なってください。

MIDIチャンネルとMIDIポート
MIDIチャンネルは「16」までしか規定されていませ
んが、16チャンネルを超えるソングデータを扱えるよ
うにするための概念として「MIDIポート」があり、
1ポートあたり16チャンネルを扱えるようになってい
ます。MIDIケーブルでは同時に1ポート分(16チャン
ネル分)のデータしか通信できませんが、USBケーブ
ルでは最大8ポート分(16×8=128チャンネル分)の
MIDIデータを扱えます。
MODXでは、USB端子を使って接続する場合、扱え
るポートがそれぞれの用途によって、下記のとおり固
定で決まっています。

ポート1
MODXの音源部が扱えるポートです。外部MIDI機器や
コンピューターからMODXの音源部を鳴らしたい場合
は、外部MIDI機器やコンピューター側でポート1に設
定する必要があります。

ポート3
MODXが受信したMIDIデータを、別のMIDI機器にそ
のまま転送する(スルーさせる)場合に使われるポート
です。

MODXでは、[USB TO HOST]端子経由で受信した
MIDIポート3のデータは、MIDI [OUT]端子からス
ルーされ、MIDI [IN]端子経由で受信したMIDIデータ
は、MIDIポート3のデータとして[USB TO HOST]端
子からスルーされます。
MODXとコンピューター間で、USBケーブルを使っ
てMIDI送受信をする場合、MIDIチャンネルだけでな
く、MIDIポートも送信側と受信側で合わせる必要があ
ります。上記用途に合わせて、外部機器側のポートの
設定を行なってください。

オーディオチャンネルについて
MODXのオーディオ信号の出力先は、[USB TO 
HOST]端子とOUTPUT [L/MONO]/[R]端子です。
コンピューターと直接接続する場合は[USB TO 
HOST]端子を使います。この場合、扱えるオーディオ
チャンネルは、最大10チャンネル(5ステレオチャンネ
ル)です。各チャンネルにどの信号を出力するかは、
[EDIT] → [Part Settings] → [General]画面の
「Part Output」で設定します。

MODXのオーディオ信号の入力は、[USB TO HOST]
端子とA/D INPUT [L/MONO]/[R]端子から行ないま
す。
[USB TO HOST]端子からのオーディオ信号は最大4
チャンネル(2ステレオチャンネル)で、ミキシング画面
またはパフォーマンスエディット画面で出力レベルを
設定し、OUTPUT [L/MONO]/[R]端子(2チャンネル)
に出力されます。また、A/D INPUT [L/MONO]/[R]
端子からのオーディオ信号も最大2チャンネル(1ステ
レオチャンネル)で、本体のA/Dインプット部に送られ
ます。
詳しくはリファレンスマニュアルをご参照ください。
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コンピューターと接続して使う

コンピューターを活用した音楽制作
MODXとコンピューターを接続することで、DAWソフト
ウェアと連携して以下のような使い方ができます。

• MODXの演奏をコンピューター上のDAWソフトウェアに
MIDI録音やオーディオ録音する

• DAWソフトウェアのソング再生をMODXの音源で行なう

ここでは、すでに本体とコンピューターとの接続(55ページ)
は済ませたものとして、DAWソフトウェアとMODXを組み
合わせた使い方の例を紹介します。

DAWに本体の演奏をMIDI録音する
(アルペジオ録音をしない場合)

MODX本体の演奏をDAWにMIDI録音する方法です。実際
に鍵盤で演奏した情報のみが記録されるため、アルペジオの
フレーズは録音されません。

MODX側の設定

1 [UTILITY]ボタンを押してユーティリティー画面
を開きます。

2 画面左の[Settings]タブ → [Quick Setup]タ
ブをタッチし、クイックセットアップ画面を開き
ます。

3「Quick Setup」の1(MIDI Rec on DAW)を
選択します。

4 [EXIT]ボタンを押して、録音するパフォーマンス
を選びます。

DAWソフトウェア側の設定

1 MIDIスルーをオンにします。
MIDIスルーとは、キーボードから入力されたMIDIデー
タが、レコーディング中のトラックの設定に従って再び
外部に出力され、MIDI音源を鳴らす設定のことです。た
とえば、図のようにMODXからCH1でデータが入力さ
れた場合でも、MIDIスルーをオンにしていると、レコー
ディングトラックの設定に従ってCH3で再び出力され、

CH3の音源が鳴ります。この設定にすることで、再生時
と同じ音を聴きながらレコーディングできます。

2 DAW側でMODXの演奏を録音します。

DAWに本体の演奏をMIDI録音する
(アルペジオ録音をする場合)

MODXのアルペジオをDAWにMIDI録音する方法です。

MODX側の設定

1 [UTILITY]ボタンを押してユーティリティー画面
を開きます。

2 画面左の[Settings]タブ → [Quick Setup]タ
ブをタッチし、クイックセットアップ画面を開き
ます。

3「Quick Setup」の2(Arp Rec on DAW)を選
択します。

4 [EXIT]ボタンを押して、録音するパフォーマンス
を選びます。

DAWソフトウェア側の設定
「DAWに本体の演奏をMIDI録音する(アルペジオ録音をしな
い場合)」と同様です。

[USB TO HOST]端子

音源部
CH3が鳴る

鍵盤
CH1

ローカルコントロール＝オフ

IN
CH1

OUT
CH3

MIDIスルー＝オンコンピューター
（Cubaseなど）

MODX
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コンピューターと接続して使う

DAWのソングを本体音源を使って鳴らす

MODX本体を、DAWソフトウェアのMIDIマルチ音源とし
て利用する方法です。コンピューターに負荷をかけずに、
クオリティーの高いMIDI音源として利用できます。

MODX側の設定

1 パフォーマンスを選びます。

2 パフォーマンスプレイ画面から[Mixing]タブを
タッチして、ミキシング画面を開きます。

3 曲に合わせてパート1～16のミキシングを設定し
ます。

DAWソフトウェア側の設定

1 MODXの音を鳴らすトラックは、MIDI出力ポー
トをMODXのポート1に設定します。

2 各トラックにMIDIデータを入力します。
各トラックのMIDIチャンネルに対応した音源の設定は
MODX側のミキシングモードで行ないます。
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MEMO
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ユーティリティー画面では、システム全体の設定の他に本体で作成したパフォーマンス、ライブセットなどのデータをUSBフ
ラッシュメモリーに保存(セーブ)したり、USBフラッシュメモリーからデータを読み込んだり(ロード)します。
ここでは、MODXのユーザーメモリー上のすべてのデータを保存(セーブ)する方法と、再度本体に読み込む(ロード)方法を説
明します。

本体の設定をUSBフラッシュメモ
リーにセーブする

1 USBフラッシュメモリーをMODXの[USB TO 
DEVICE]端子に接続します。

2 [UTILITY]ボタンを押してユーティリティー画面
を開いたあと、画面左の[Contents]タブ → 
[Store/Save]タブをタッチします。

3「Content Type」で「User File (ユーザー
ファイル)」を選択します。

4 保存先のUSBフラッシュメモリー、フォルダーを
選択します。

1 親フォルダー名

2 USBフラッシュメモリー内の保存先として、現在設
定されているフォルダー名

3 新規保存先

4 すでに保存されているファイルの一覧

5 [Save As New File]の「＋」をタッチします。
NOTE
すでに保存されているファイルを上書きする場合はそのファイル名
をタッチします。

6 文字入力画面が表示され、保存するファイルの名
前を設定します。
名前の設定方法について詳しくは、「基本操作と画面表
示」の「文字入力」(21ページ)をご参照ください。

7 文字入力画面の「Done」を選択すると、セーブ
が実行されます。
NOTE
すでに保存されているファイルを上書きする場合は、手順5のあとに
実行確認の画面が表示されるので、「YES」を選択するとセーブが実
行されます。

USBフラッシュメモリーにセーブ
した本体の設定をロードする
注記
ロードを実行すると、本体に保存されていたデータは消えてしまいます。
大切なデータは、あらかじめUSBフラッシュメモリーに保存(セーブ)し
ておくことをおすすめします。

1 USBフラッシュメモリーをMODXの[USB TO 
DEVICE]端子に接続します。

2 [UTILITY]ボタンを押してユーティリティー画面
を開いたあと、画面左の[Contents]タブ → 
[Load]タブをタッチします。

3「Content Type」で「User File (ユーザー
ファイル)」を選択します。

4 ロード元のUSBフラッシュメモリー、フォルダー
を選択します。

本体の設定をセーブ/ロードする

コンテンツタイプを選択

1 2

3

4
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本体の設定をセーブ/ロードする

5 USBフラッシュメモリー内のファイル(拡張子: 
.X8U)を選択して、ロードを実行します。

1 ロード元のUSBフラッシュメモリー

2 USBフラッシュメモリー内のロード元として、現在
設定されているフォルダー名

3 すでに保存されているファイルの一覧

[USB TO DEVICE]端子
ご使用上の注意
本機には[USB TO DEVICE]端子があります。[USB TO 
DEVICE]端子にUSB機器を接続する場合は、以下のことを
お守りください。

NOTE
USB機器の取り扱いについては、お使いのUSB機器の取扱説明書もご参
照ください。

■ 使用できるUSB機器
• USBフラッシュメモリー 

上記以外のUSB機器(USBハブ、マウス、コンピューター
のキーボードなど)は、接続しても使えません。

動作確認済みUSB機器については、ご購入の前にインター
ネット上の下記URLでご確認ください。

https://jp.yamaha.com/support/

「その他のドキュメント」から検索

本機では、USB1.1～3.0の機器がご使用できますが、機器
への保存や機器からの読み込みにかかる時間は、データの種
類や本機の状態により異なります。

NOTE
[USB TO DEVICE]端子の定格は、最大5V/500mAです。定格を超え
るUSB機器は故障の原因になるため、接続しないでください。

■ USB機器の接続
[USB TO DEVICE]端子の形状に合うプラグを上下の向き
に注意して差し込んでください。
注記
• USBフラッシュメモリーの抜き差しは、再生や録音中、ファイル操作
中(保存/コピー /削除/フォーマットなど)、およびUSB機器へのアク
セス中には行なわないでください。楽器本体の機能が停止したり、
USBフラッシュメモリーやデータが壊れたりするおそれがあります。

• USBフラッシュメモリーの抜き差しは、数秒間隔を空けて行なってく
ださい。

USBフラッシュメモリーの取り扱いにつ
いて

本機にUSBフラッシュメモリーを接続すると、楽器本体で
制作したデータをUSBフラッシュメモリーに保存したり、
USBフラッシュメモリーのデータを楽器本体で再生したり
できます。

■ 接続できるUSBフラッシュメモリーの数
同時に使用できるUSBフラッシュメモリーは、１つです。

■ USBフラッシュメモリーのフォーマット
USBフラッシュメモリーは本機でフォーマットすることを
おすすめします。他の機器でフォーマットしたUSBフラッ
シュメモリーは、本機で正しく動作しない場合があります。
注記
フォーマットを実行すると、そのUSBフラッシュメモリーの中身は消去
されます。必要なデータが入っていないのを確認してからフォーマット
してください。

NOTE
フォーマットの方法は、リファレンスマニュアルをご参照ください。

■ 誤消去防止
USBフラッシュメモリーには、誤ってデータを消してしま
わないようライトプロテクト機能のついたものがあります。
大切なデータが入っている場合は、ライトプロテクトで書き
込みができないようにしましょう。逆にデータを保存する場
合などは、ご使用の前にお使いのUSBフラッシュメモリー
のライトプロテクトが解除されていることをご確認くださ
い。

■ USBフラッシュメモリー接続時に電源を
切るには

電源を切る場合は、再生/録音やファイル操作(保存/コピー
/削除/フォーマットなど)によるUSBフラッシュメモリーへ
のアクセス中でないことを確認してください。USBフラッ
シュメモリーやデータが壊れるおそれがあります。

1 2

3

https://jp.yamaha.com/support/
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1

[SHIFT]ボタンと他のボタンを組み合わせることで、以下のショートカット機能が実現されます。

シフト機能一覧

操作 機能

[SHIFT] + [KNOB POSITION 1] ノブに割り当てられたAssign 1～8の値をValue 1に記録

[SHIFT] + [KNOB POSITION 2] ノブに割り当てられたAssign 1～8の値をValue 2に記録

[SHIFT] + [OCTAVE-] トランスポーズ値を－1(減らす)

[SHIFT] + [OCTAVE+] トランスポーズ値を＋1(増やす)

[SHIFT] + [OCTAVE-] + [OCTAVE+] トランスポーズ値を0に戻す

[SHIFT] + [DEC/NO] 選択しているパラメーター値を－10(減らす)
ライブセット画面では前のページを表示

[SHIFT] + [INC/YES] 選択しているパラメーター値を＋10(増やす)
ライブセット画面では次のページを表示

[SHIFT] + [ENTER] テンポセッティング画面に移行

[SHIFT] + [PERFORMANCE (HOME)] オーバービュー画面に移行

[SHIFT] + [LIVE SET] ライブセット登録画面に移行

[SHIFT] + [UTILITY] クイックセットアップ画面に移行

[SHIFT] + [CATEGORY] 選択中のパートのパートカテゴリーサーチ画面を開く

[SHIFT] + スライダーセレクト[1-4]/[5-8] スライダーファンクション[PART]/[ELEMENT/OPERATOR]ボタンがPARTの場合は
Part 9またはPart 13を選択

[SHIFT] + [EDIT] Copy/Exchangeダイアログの表示

[SHIFT] + SCENE [1]～[8] シーン1～8をSCENE [1]～[8]ボタンにそれぞれ記録

[UTILITY] + [PART SELECT MUTE/SOLO] タッチパネルキャリブレーション設定に移行
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メッセージリスト

メッセージ 説明

** will be deleted. 操作を実行することによりデータが削除される場合に表示されます。

** will be overwritten. セーブ時に同じ名前のファイル/フォルダ―がすでに存在している場合に表示されます。セー
ブを実行するとデータは上書きされます。**にはセーブしようとしているファイル/フォル
ダー名が表示されます。

Activate the source controller to assign. 今から操作するコントローラーにパラメーターを割り当てることができます。割り当てを希
望するコントローラーを操作してください。

Advanced settings will be initialized. [Advanced]タブで行なわれた設定を初期化します。

All data and libraries will be initialized. Unsaved 
user data will be lost. 

工場出荷時の設定に戻します。必要なデータは、前もってUSBフラッシュメモリーに保存す
ることをおすすめします。

All data is initialized upon power-on. 電源を入れたとき、工場出荷状態に戻すように設定されました。

All settings will be initialized. User data is kept. 本体の設定を初期化します。ユーザーデータは削除されません。

All sound will be stopped during optimization. 本体メモリーの修復を開始します。

All user data will be initialized. Unsaved user data 
will be lost. 

ユーザーデータを初期化します。必要なデータは、前もってUSBフラッシュメモリーに保存
することをおすすめします。

Are you sure? 各操作を実行したときの、確認を求める表示です。

Arpeggio full. アルペジオパートスイッチが、これ以上オンにできないときに表示されます。

Assignable Knob Full. スーパーノブの設定を追加しようとしたとき、すべてのアサイナブルノブがすでに割り当て
済みの場合に表示されます。

Audio Rec stopped due to lack of memory space. USBフラッシュメモリーの容量がいっぱいのため、オーディオ録音が自動停止した場合に表
示されます。新しいUSBフラッシュメモリーを用意するか、不要なファイルを消去してから
操作をやりなおしてください。

Auto power off disabled. オートパワーオフ機能が解除されます。

Bulk data protected. バルクデータ受信のプロテクトがかかっています。

Can’t process. 処理に失敗しました。

Completed. ロード、セーブ、フォーマット、ジョブなどの実行が完了したときに表示されます。

Connecting to USB device... USBフラッシュメモリーを接続中です。

Control Assign Full. すべてのコントロールアサインが使用中の場合に表示されます。

Copy protected. 著作権保護されているデジタルオーディオソースのため、ファイルセーブなどができません。

Current user data will be overwritten by **. ファイルの読み込み時にユーザーデータがすでに存在している場合に表示されます。読み込
みを実行するとユーザーデータは上書きされます。**にはロードしようとしているユーザー
ファイル名が表示されます。

Data memory full. (ライブラリーファイル読み込み時)本体メモリーがいっぱいで、ライブラリー内のコンテン
ツデータが保存できない場合に表示されます。

Device number is off. デバイスナンバーがオフなので、バルクデータを送受信できません。

Device number mismatch. デバイスナンバーが異なるので、バルクデータを送受信できません。

File is not found. 選択したタイプのファイルがありません。

File or folder already exists. 同じ名前のファイルまたはフォルダ―がすでに存在しています。

File or folder path is too long. 開こうとするファイルやフォルダーのパス名が長すぎて開けません。

Folder is not empty. データの入っているフォルダ―を消去しようとした場合に表示されます。

Illegal bulk data. バルクデータ、バルクリクエスト受信中にエラーが生じました。

Illegal file name. ファイル名が無効の場合に表示されます。

Illegal file. 目的のファイルがMODXでは扱えない、またはロードできない場合に表示されます。

Keybank full. ロードの実行時に、キーバンク数の合計が最大数を超える場合に表示されます。

Library full. ライブラリー数の合計が最大数を超える場合に表示されます。

MIDI buffer full. 一度に大量のMIDIデータを受信したので処理できませんでした。

MIDI checksum error. 受信したシステムエクスクルーシブのチェックサムが違います。

Modified: Common AsgnKnob? パートエディットのコントロールアサイン画面で、スーパーノブと関連したアサイナブルノ
ブの設定を追加または変更した場合、コモン/オーディオエディットのコントロールアサイン
設定が自動的に追加または変更されたときに表示されます。
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メッセージリスト

No data. 選択したトラックや設定した範囲にデータがないときに表示されます。範囲を選びなおして
ください。

No read/write authority to the file. ファイルの読み取り権限および書き込み権限がありません。

Now initializing all data… 工場出荷時の設定に書き換え中です。

Now initializing… 一部のデータ初期化中に表示されます。

Now loading... ファイルロード中に表示されます。

Now receiving MIDI bulk data... MIDIバルクデータ受信中に表示されます。

Now saving... ファイルセーブ中に表示されます。

Now transmitting MIDI bulk data... MIDIバルクデータ送信中に表示されます。

Part Full. すべてのパートが使用中の場合に表示されます。

Please connect USB device. USBフラッシュメモリーを接続してください。

Please keep power on. フラッシュROMへのデータの書き込み中です。表示中は絶対に電源を切らないでください。
表示中に電源を切ると、ユーザーデータが失なわれたり、システムが壊れて次に電源を入れ
たときに正常に立ち上がらなくなる恐れがあります。

Please reboot to enable the new Audio I/O Mode. オーディオの入出力設定の変更を有効にするために、本機を再起動してください。

Please reboot to maintain internal memory. 本体メモリーの修復を行ないますので、本機を再起動してください。

Please stop audio play/rec. オーディオの録音または再生を停止してから操作してください。

Please stop sequencer. シーケンサー (ソング)を停止してから操作してください。

Please wait… 処理を実行中です。しばらくお待ちください。

Recall latest edits. あるパフォーマンスをエディットしているときに、ストアしないまま別のパフォーマンスを
選ぶと、エディット中のデータは失なわれてしまいます。このような場合に、リコール機能
を実行すると、元のデータ(エディット中の状態)を呼び戻すことができます。

Redo last recording. アンドゥーで一度取り消した操作をもう一度やり直します(リドゥー )。

Sample is protected. サンプルにプロテクトがかかっているので、書き換えができません。

Sample is too long. サンプルのサイズが大きすぎてロードが実行できない場合に表示されます。

Sample memory full. サンプル用のメモリーがいっぱいで、ロードなどが実行できない場合に表示されます。

Scene stored. [SCENE]ボタンにシーンがストア(保存)されました。

Song data overload. ソングの負荷が大きすぎて再生できない場合に表示されます。

Song full. ソング数の合計が最大数を超える場合に表示されます。

Touch the white square. (タッチパネルのキャリブレーション時)表示された白い四角いマークをタッチするよう促す
ために表示されます。

Turn on Memory Switch to memorize ** into this 
scene.

機能をシーンとして記録するには、該当機能の[Memory] (Memory Switch)をあらかじめ
オンにしておく必要があります。

Undo last recording. 直前に行なった録音を取り消します(アンドゥー )。

Unsupported USB device. このUSBデバイスは本機に対応していません。

USB connection terminated. USBフラッシュメモリーに異常な電流が流れたので接続を遮断しました。接続している
USBフラッシュメモリーを外したうえで、パネル上のなんらかのボタンを押してください。

USB device is full. USBフラッシュメモリーの容量がいっぱいでファイルがセーブできない場合に表示されま
す。新しいUSBフラッシュメモリーを用意するか、不要なファイルを消去してから操作をや
りなおしてください。

USB device is write-protected. 書込み禁止状態になっているUSBフラッシュメモリーへの書き込みを行なおうとした場合に
表示されます。

USB device read/write error. USBフラッシュメモリーへのリード/ライト中にエラーが発生しました。

USB device will be formatted. USBフラッシュメモリーをフォーマットします。

Waveform full. ウェーブフォーム数の合計が最大数を超える場合に表示されます。

メッセージ 説明
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「音が出ない」「音色がおかしい」などといった場合は、まず以下の項目をチェックしてください。また、USBフラッシュメモ
リーにデータのバックアップをしてから(60ページ)、イニシャライズ オールデータ (19ページ)を実行することで解決できる
こともあります。それでも直らないときは、お買い上げのお店、または巻末の問い合わせ窓口にご連絡ください。

タッチパネルの反応が悪い
 タッチパネルのタッチ位置と本体動作がずれていませんか？
タッチパネルのキャリブレーションを行なってください。

音が鳴らない
 コントロールスライダーがすべて最少になっていませんか？

 本体に外部アンプやスピーカー、ヘッドフォンが接続されていますか?
本体にはスピーカーが内蔵されていません。音を出すためには、外部アンプやスピーカー、ヘッドフォンなどを接続してください
(18ページ)。

 本体と、本体に接続した外部オーディオ機器の電源は、オンになっていますか？

 本体と、本体に接続した外部オーディオ機器のマスターボリュームは、十分に上がっていますか？
[FOOT CONTROLLER]端子にフットコントローラーを接続している場合は、動かしてみてください。

 ローカルコントロールがオフになっていませんか?
このパラメーターがオフの場合、鍵盤を弾いても内部音源は鳴りませんのでご注意ください。

 未使用のパートが選択されていませんか？
音色を割り当てるか、他のパートを選択してください。

 各パートのミュートスイッチがオンになっていませんか？
ミュートスイッチがオンに設定してあると、鍵盤を弾いても音が鳴りませんのでご注意ください。

 各パートのキーボードコントロールがオフになっていませんか？

 選択中のパートの「Arp Play Only」(アルペジオ プレイ オンリー )がオンになっていませんか?
このパラメーターをオンにすると、該当パートはアルペジエータ―のノートオンでのみ発音する状態になります。

 外部MIDIコントローラーによって、MIDIボリュームやエクスプレッションが下がってはいませんか？

 エフェクトやフィルターの設定は適切ですか？
特にフィルターをかける場合、カットオフ周波数によっては音が出ない場合があります。

•ノーマルパート(AWM2)、ドラムパートの場合

•ノーマルパート(FM-X)の場合

 パートのインサーションエフェクトがボコーダーに設定されていませんか？
ボコーダーに設定されている場合は、A/D INPUT [L/MONO]/[R]端子の設定を適切な値に設定し、A/D INPUT [L/MONO]/[R]
端子に音声を入力しながら発音させてください。またその際、パネルのA/D INPUT [GAIN]ノブが最小になっていないか確認して
ください。

困ったときは

[UTILITY]＋[PART SELECT MUTE/SOLO] → [ENTER]

[UTILITY] → [Settings] → [System] →「Calibrate Touch Panel」

[UTILITY] → [Settings] → [MIDI I/O] →「Local Control」

[PERFORMANCE (HOME)] → パートの「Mute」

[PART SELECT MUTE/SOLO] →「Mute」→ パート選択

[PERFORMANCE (HOME)] → パートの「Kbd Ctrl」

[PERFORMANCE (HOME)] → パート選択 →[EDIT] → [Part Settings] → [General] →「Arp Play Only」

[PERFORMANCE (HOME)] → パート選択 →[EDIT] → [Arpeggio] → [Common] →「Arp Play Only」

[PERFORMANCE (HOME)] →[EDIT] → [Effect]

[PERFORMANCE (HOME)] → パート選択 →[EDIT] → [Effect]

[PERFORMANCE (HOME)] → パート選択→[EDIT] → エレメント/キー選択 → [Filter]

[PERFORMANCE (HOME)] → パート選択→[EDIT] → オペレーター選択→ [Pitch/Filter]

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Effect] → [Routing]
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困ったときは

 ボリュームやレベルが最小になっていませんか？

•ノーマルパート(AWM2)、ドラムパートの場合

•ノーマルパート(FM-X)の場合

 エレメントスイッチ、ノートリミット、ベロシティーリミット、ベロシティーオフセットの設定は適切ですか？
•ノーマルパート(AWM2)、ドラムパートの場合

•ノーマルパート(FM-X)の場合

 パートの各エレメント/オペレーターのミュートスイッチがオンになっていませんか？

 

 (ノーマルパート(FM-X)の場合)キャリアのレベルが0になっていませんか？

 パートの出力設定がオフになっていませんか？

A/D INPUT端子からの音が出ない
 接続しているマイクのスイッチはオンになっていますか？

 接続しているマイクはダイナミックマイクですか?

 マイクまたは外部オーディオ機器と本体を接続するケーブルは正しく接続されていますか？

 A/D INPUT [GAIN]ノブが最小になっていませんか？

 A/D INPUT [ON/OFF]ボタンがオン(ランプが点灯)になっていますか？

 A/D INPUT [L/MONO]/[R]端子の接続状態と「Mono/Stereo」の設定が合っていますか?

「Mic/Line」設定は適切ですか？
マイクなどの出力レベルの低い機器を接続した場合は「Mic」(マイク)に、オーディオ機器、電子楽器などの出力レベルの高い機器
を接続した場合は「Line」(ライン)に設定します。

 A/Dインプットパートのボリュームが最小になっていませんか？

 A/Dインプットパートのエフェクトの設定は適切ですか？

 A/Dインプットパートの出力設定は適切ですか？

 

 ボコーダーエフェクトを使用する設定になっていませんか？
インサーションエフェクトにボコーダーを使用する設定になっている場合、A/D INPUT [L/MONO]/[R]端子からの入力音は鍵盤
を弾かないと鳴らないことがあります。

[UTILITY] → [Settings] → [Sound] → Tone Generator「Volume」

[EDIT] → [General] →「Volume」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Part Settings] → [General] →「Volume」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Part Settings] → [General] →「Dry Level」

[EDIT] → パート選択 → エレメント/キー選択 → [Amplitude] → [Level/Pan] →「Level」

[EDIT] → パート選択 → オペレーター選択 → [Level] →「Level」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Part Settings] → [General]

[EDIT] → パート選択 → エレメント/キー選択 → [Osc/Tune]

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common]  → [Part Settings] → [General]

[EDIT] → パート選択 → 各エレメント/オペレーターのミュートスイッチ確認

[EDIT] → パート選択 → オペレーター選択 → [Level] →「Level」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Part Settings] → [General] →「Part Output」

[EDIT] → [Audio In] → [Mixing] → A/D In「Input Mode」

[UTILITY] → [Settings] → [Audio I/O] →「A/D Input」

[EDIT] → [Audio In] → [Mixing] → A/D In「Volume」

[EDIT] → [Audio In] → [Routing]

[UTILITY] → [Settings] → [Audio I/O] → Output

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Effect] → [Routing]
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困ったときは

音が鳴り続けて止まらない
 [ARP ON/OFF]ボタンがオンになっている場合、オフにしてみてください。

 ソング画面の場合は、[■](ストップ)ボタンを押してください。

 ディレイなどのエフェクトで音が鳴り続けている場合は、エフェクトの設定を変えるか、音色を選び直してください。

 クリック音が鳴り続けている場合は、以下の設定を確認してください。「always」 (オールウェイズ)に設定されていれば常に鳴って
いますので、「always」以外に設定してください。

音が歪む
 エフェクトの設定は適切ですか？
エフェクトタイプや設定によっては、音が歪む場合があります。

 フィルターの設定は適切ですか？
フィルターをかける場合、レゾナンスによっては音が歪む場合があります。
•ノーマルパート(AWM2)、ドラムパートの場合

•ノーマルパート(FM-X)の場合

 ボリュームを上げすきていませんか？

•ノーマルパート(AWM2)、ドラムパートの場合

•ノーマルパート(FM-X)の場合

音が途切れる
 全体の発音数が最大同時発音数(AWM2は128音、FM-Xは64音)を超えていませんか？

同時に複数の音(和音)が発音できない
 発音方式が「モノ(mono)」になっていませんか？
和音を鳴らしたい場合は「ポリ(Poly)」に設定してください。

ピッチがずれている
 チューンの設定が、0から大きく離れていませんか。

 各パートのノートシフト、デチューンが0以外に設定されていませんか？
•ノーマルパート(AWM2)、ドラムパートの場合

•ノーマルパート(FM-X)の場合

[UTILITY] → [Tempo Settings] → Click「Mode」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Effect]

[EDIT] → パート選択 → エレメント/キー選択 → [Filter]

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Pitch/Filter]

[UTILITY] → [Settings] → [Sound] → Tone Generator「Volume」

[UTILITY] → [Settings] → [Audio I/O] →「Output」

[EDIT] → [General] →「Volume」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Part Settings] → [General] →「Volume」

[EDIT] → パート選択 → エレメント/キー選択 → [Amplitude] → [Level/Pan] →「Level」

[EDIT] → パート選択 → オペレーター選択 → [Level] →「Level」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Part Settings] → [General] →「Mono/Poly」

[UTILITY] → [Settings] → [Sound] → Tone Generator「Tune」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Part Settings] → [Pitch] →「Note Shift」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Part Settings] → [Pitch] →「Detune」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Pitch/Filter] → [Pitch] →「Note Shift」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Pitch/Filter] → [Pitch] →「Detune」
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困ったときは

 パートのピッチがずれている場合、マイクロチューニング設定で特殊な音律が選ばれていませんか？
•ノーマルパート(AWM2)の場合

•ノーマルパート(FM-X)の場合

 パートのピッチがずれている場合、LFOピッチモジュレーションデプスが強くかかりすぎてはいませんか?
•ノーマルパート(AWM2)の場合

•ノーマルパート(FM-X)の場合

 パートのピッチがずれている場合、コースチューンやファインチューンがずれていませんか?
•ノーマルパート(AWM2)、ドラムパートの場合

•ノーマルパート(FM-X)の場合

 パートのピッチがずれている場合、コントローラーのデスティネーションがピッチに設定されていませんか？

エフェクトがかからない
 エフェクトスイッチがオフになっていませんか？

 バリエーションセンド、リバーブセンドの値が最小になっていませんか？

 バリエーションリターン、リバーブリターンの値が最小になっていませんか？

 パートの全エレメント/キー /が、インサーションエフェクトをスルー (Thru)するように設定されていませんか？

 (システムエフェクトの場合)各エフェクトで選択されているエフェクトタイプが、ノーエフェクト(No Effect)に設定されていませ
んか？

 (インサーションエフェクトの場合)各エフェクトで選択されているエフェクトタイプが、スルー (Thru)に設定されていませんか？

 インサーションスイッチの設定は適切ですか？

 インサーションエフェクトが掛けられるパート数を超えていませんか？
パート9～16までのうち、インサーションエフェクトがかけられるのは4パートまでです。

アルペジオが鳴らない
 [ARP ON/OFF]ボタンはオンになっていますか？

 アルペジオスイッチがオンになっているパート数を確認してください。
同時にアルペジオをかけられる最大パート数は8です。

 アルペジオのノートリミットやベロシティーリミットは、適切に設定されていますか？

 アルペジオタイプがオフ(Off)に設定されていませんか？

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Part Settings] → [Pitch] →「Micro Tuning Name」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Pitch/Filter] → [Pitch] →「Micro Tuning Name」

[EDIT] → パート選択 → エレメント選択 → [Element LFO] →「Pitch Mod」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Mod/Control] → [2nd LFO] →「Pitch Modulation」

[EDIT] → パート選択 → エレメント/キー選択 → [Osc/Tune] →「Coarse」

[EDIT] → パート選択 → エレメント/キー選択 → [Osc/Tune] →「Fine」

[EDIT] → パート選択 → オペレーター選択 → [Form/Freq] →「Coarse」

[EDIT] → パート選択 → オペレーター選択 → [Form/Freq] →「Fine」

[EDIT] → パート選択 → [Mod/Control] → [Control Assign] →「Destination」

[UTILITY] → [Effect Switch]

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Effect] → [Routing] →「Var Send」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Effect] → [Routing] →「Rev Send」

[EDIT] → [Effect] → [Routing] →「Var Return」

[EDIT] → [Effect] → [Routing] →「Rev Return」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Effect] → [Routing] →「Element 1-8」

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Effect] → [Ins A]/[Ins B]

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Effect] → [Ins Assign]

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Arpeggio] → [Common]

[EDIT] → パート選択 → [Arpeggio] → [Indivisual] →「Name」
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困ったときは

 各パートのアルペジオスイッチの設定を確認してください。
アルペジオスイッチがオフに設定してあると、パネルの[ARP ON/OFF]ボタンをオンにしてもアルペジオは再生されません。

 [Arp Bypass]ボタンがオンになっていませんか？

アルペジオが止まらない
 鍵盤から指を離してもアルペジオ再生が止まらない場合は、アルペジオ ホールド スイッチの設定をオフにしてください。

[R](プレイ)ボタンを押してもソング再生がスタートしない
 選んでいるソングにデータは入っていますか？

ソングを録音できない
 ソング用の容量が少なくなっていませんか？
ソングのメモリー容量は、128ソングです。したがって、128ソングを超えるとソングフル(Song full)となって録音ができなくな
ります。

本体と接続したコンピューターとの通信がうまくできない
 コンピューター側でのポート設定はできていますか？

 ユーティリティー画面で、使用する端子(MIDI、USB)を選んでいますか？

バルクダンプデータがうまく送信/受信できない
 バルク受信(レシーブバルク)をプロテクトしていませんか？
バルク受信をオンに設定してください。

 本体のバルクダンプ機能を使って記録したデータを受信するときは、送信時と同じデバイスナンバーに設定する必要があります。

 デバイスナンバーの設定値が、接続しているMIDI機器のデバイスナンバーと一致していますか?

USBフラッシュメモリーにセーブできない
 USBフラッシュメモリーにライトプロテクトがかかっていませんか？

 USBフラッシュメモリーの空き容量は足りていますか？
コンテンツ画面に入り、デバイスをUSBフラッシュメモリーに設定してください。画面の右上に表示されるストレージの空き容量
が 0.0KBになっていないか確認してください。

 USBフラッシュメモリーは、本体と動作確認済みのものを使用されていますか? (61ページ)

ディスプレイ内に、点灯しない点や点灯したままの点がある
 カラー LCDの特性です。故障ではありません。

[PERFORMANCE (HOME)] → パート選択 →「Arp On」

[UTILITY] → [Effect Switch]

[EDIT] → パート選択 → エレメント/キー /オペレーター [Common] → [Arpeggio] → [Common] →「Hold」

[UTILITY] → [Settings] → [MIDI I/O] → MIDI「MIDI IN/OUT」

[UTILITY] → [Settings] → [Advanced] → MIDI「Receive Bulk」

[UTILITY] → [Settings] → [Advanced] → MIDI「Device Number」

[UTILITY] → [Settings] → [Advanced] → MIDI「Device Number」

[UTILITY] → [Contents] → [Load]/[Store/Save]
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仕様

鍵盤 MODX8: 88鍵GHS鍵盤(イニシャルタッチ付）
MODX7: 76鍵セミウェイテッド鍵盤(イニシャルタッチ付）
MODX6: 61鍵セミウェイテッド鍵盤(イニシャルタッチ付）

音源部 音源方式 Motion Control Synthesis Engine
AWM2: 8エレメント
FM-X: 8オペレーター、88アルゴリズム

最大同時発音数 AWM2: 128音(ステレオ/モノ波形いずれも)、FM-X: 64音

マルチティンバー数 内蔵音源16パート、オーディオ入力パート(A/D*1、USB*1)
*1 ステレオパート

波形メモリー プリセット: 5.67GB相当(16bitリニア換算)、ユーザー : 1.0GB

パフォーマンス数 約2,000

フィルター 18タイプ

エフェクター リバーブ×12タイプ、バリエーション×85タイプ、
インサーション(A、B)×85タイプ *2、マスターエフェクト×23タイプ
*2 A/Dパートインサーションは80タイプ

<各エフェクトタイプにプリセットプログラム搭載>
マスターEQ (5バンド)、 1stパートEQ (3バンド)、 2ndパートEQ (2バンド)

シーケンサー
部

シーケンサー容量 約130,000音

音符分解能 四分音符/480

テンポ(BPM) 5～300

パフォーマンス
レコーダー

曲数 128曲

トラック 16シーケンサートラック、テンポトラック、シーントラック

レコーディング
方式

リアルタイムリプレース、リアルタイムオーバーダブ、リアルタイムパンチ

再生 MODXオリジナルフォーマット、SMFフォーマット0,1

アルペジエーター パート 最大8パート同時オン可

プリセット 10,239タイプ

ユーザー 256タイプ

モーション
シーケンサー

レーン 最大8+1系統

その他 ライブセット数 プリセット:  256、ユーザー : 2,048

主な操作子 マスターボリューム、A/Dインプットゲインノブ、USBボリューム、
ピッチベンドホイール、モジュレーションホイール、
コントロールスライダー×4、ノブ×4、スーパーノブ、データダイアル

ディスプレイ 7インチ ワイドVGA TFTカラー LCD (タッチパネル付)

接続端子 [USB TO DEVICE]、[USB TO HOST]、MIDI [IN]/[OUT]、
FOOT CONTROLLER [1]/[2]、FOOT SWITCH [ASSIGNABLE]/[SUSTAIN]、
OUTPUT [L/MONO]/[R] (標準フォーンジャック)、
[PHONES] (ステレオ標準フォーンジャック)、
A/D INPUT [L/MONO]/[R] (標準フォーンジャック)

USBオーディオ
インターフェース

サンプリング
周波数

44.1kHz

入出力
チャンネル数

入力：4チャンネル（ステレオ2チャンネル）
出力：10チャンネル（ステレオ5チャンネル）

消費電力 16W (電源アダプターPA-150B使用時)
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本書は、発行時点での最新仕様で説明しています。最新版は、ヤマハウェブサイトからダウンロードできます。

その他 寸法・質量 MODX8: 1,333 (W) × 404 (D) × 160 (H) mm、13.8kg
MODX7: 1,144 (W) × 331 (D) × 134 (H) mm、7.4kg
MODX6: 937 (W) × 331 (D) × 134 (H) mm、6.6kg

付属品 電源アダプター (PA-150Bまたはヤマハ推奨の同等品)、取扱説明書(本書)、保証書、
CUBASE AI DOWNLOAD INFORMATION (CUBASE AIダウンロードについて)
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A
A/D INPUT [GAIN] (A/Dインプットゲイン)ノブ ..................... 10
A/D INPUT [L/MONO]、[R] 
(A/Dインプット左/モノラル、右)端子 ....................................... 17
A/D INPUT [ON/OFF] (A/Dインプット オン/オフ)ボタン ...... 10
ABS (オーディオビートシンク) ................................................. 17
[ARP ON/OFF] (アルペジオ オン/オフ)ボタン ......................... 11
[ASSIGN] (アサイン)ボタン ..................................................... 12
[ASSIGN 1]、[ASSIGN 2] 
(アサイナブルスイッチ1、2)ボタン .......................................... 10
[AUDITION] (オーディション)ボタン ........................................ 15

C
[CATEGORY] (カテゴリー )ボタン ........................................... 15
[CONTROL ASSIGN] (コントロールアサイン) ボタン ............. 13

D
DAW ........................................................................................ 55
[DC IN] (DCイン)端子 .............................................................. 17
[DEC/NO] (デック/ノー )ボタン ............................................... 14

E
[EDIT] (エディット)ボタン ........................................................ 14
[ENTER] (エンター )ボタン ...................................................... 14
[EXIT] (エグジット)ボタン ........................................................ 14

F
FM ............................................................................................ 38
FOOT CONTROLLER [1]、[2] 
(フットコントローラー1、2)端子 ............................................. 17
FOOT SWITCH [ASSIGNABLE]、[SUSTAIN] 
(フットスイッチ アサイナブル、サステイン)端子 ....................... 17
Frequency Modulation (フリケンシーモジュレーション) ........ 38

G
GM音色 .................................................................................... 22
GMバンク ................................................................................. 22

I
[INC/YES] (インク/イエス)ボタン ............................................ 14

K
KNOB POSITION (ノブポジション) [1]、[2]ボタン ................ 13

L
[LIVE SET] (ライブセット)ボタン ............................................ 15

M
[MASTER VOLUME] (マスターボリューム)ノブ ...................... 10
MIDI [IN]、[OUT]端子 .............................................................. 17
MIDI受信チャンネル .................................................................. 54
MIDI送信チャンネル .................................................................. 54
MIDIチャンネル ......................................................................... 56
MIDIポート ............................................................................... 56
MIDI録音 ................................................................................... 45
[MOTION SEQ HOLD] 
(モーションシーケンサーホールド)ボタン .................................. 11
[MOTION SEQ ON/OFF] 
(モーションシーケンサー オン/オフ)ボタン ............................... 11
[MOTION SEQ TRIGGER] 
(モーションシーケンサートリガー )ボタン ................................. 11

O
OCTAVE (オクターブ)[－]/[＋]ボタン .......................................11
OUTPUT [L/MONO]、[R] 
(アウトプット左/モノラル、右)端子 ...........................................17

P
[PART SELECT MUTE/SOLO] 
(パートセレクト ミュート/ソロ)ボタン ......................................15
[PERFORMANCE (HOME)] (パフォーマンス(ホーム))ボタン ..14
[PHONES] (ヘッドフォン)端子 .................................................17
Power on Mode (パワーオンモード) ........................................51

R
[RHYTHM PATTERN](リズムパターン)ボタン ........................13

S
SCENE (シーン) [1/5][2/6][3/7][4/8]ボタン .......................12
[SHIFT] (シフト)ボタン .............................................................14
SSS ..........................................................................................23
[STORE] (ストア)ボタン ...........................................................14

U
[USB TO DEVICE]端子 ...................................................... 17, 61
[USB TO HOST]端子 ......................................................... 17, 56
[USB VOLUME (MONITOR)] 
(USBボリューム(モニター ))ノブ ...............................................10
[UTILITY] (ユーティリティー )ボタン ........................................14

Y
Yamaha Steinberg USBドライバー .......................................55

ア
アルペジオ .................................................................................28
アルペジオタイプ .......................................................................43
アンドゥー .................................................................................46

イ
イニシャライズパフォーマンス ..................................................25

エ
エフェクト .................................................................................39
エレメントエディット ................................................................38
エレメントコモンエディット ......................................................38
エンベロープフォロワー ....................................................... 17, 44

オ
オーディオチャンネル ................................................................56
オーディションフレーズ .............................................................25
オートパワーオフ .......................................................................19
オペレーター .............................................................................38
オペレーターエディット .............................................................38
オペレーターコモンエディット ..................................................38

カ
カーソル ....................................................................................20
カーソルボタン ..........................................................................14
カテゴリーサーチ .......................................................................24

キ
キーエディット ..........................................................................38
キーコモンエディット ................................................................38
キャリア ....................................................................................38

索引
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ク
クイックセットアップ ............................................................... 55

ケ
鍵盤 .......................................................................................... 10
鍵盤入力 .................................................................................... 21

コ
工場出荷時の状態 ...................................................................... 19
コントローラー .......................................................................... 29
コントロールスライダー1～4 (5～8/9～12/13～16） .......... 12
コンペア機能 ............................................................................. 40

シ
シーケンサートランスポートボタン ........................................... 13
シーン機能 ................................................................................ 34
シーンセレクト[1-4]/[5-8]ボタン ............................................ 12
シングルパートパフォーマンス .................................................. 22

ス
スーパーノブ ........................................................................13, 31
[P](スタンバイ/オン)スイッチ .................................................. 17
ストア ....................................................................................... 37
スプリット ................................................................................ 42
スライダーセレクト[1-4]/[5-8]ボタン ...................................... 12
スライダーファンクション[PART](パート)/
[ELEMENT/OPERATOR](エレメント/オペレーター )ボタン ... 12

セ
セーブ ....................................................................................... 60

ソ
ゾーン ....................................................................................... 49
ソロ機能 .................................................................................... 27
ソング ..................................................................................45, 47

タ
タッチパネルLCD (液晶ディスプレイ) ....................................... 13

テ
データダイアル .......................................................................... 14
テンキー入力 ............................................................................. 21
電源 .......................................................................................... 18

ト
トラック .................................................................................... 45
ドラムパート ............................................................................. 22

ノ
ノーマルパート(AWM2) ........................................................... 22
ノーマルパート(FM-X) .............................................................. 22
ノブ .......................................................................................... 30
ノブ1～4 (5～8) ...................................................................... 12
ノブファンクション[TONE]/[EG/FX]/[EQ]/[ARP/MS]ボタン 12

ハ
パートエディット ...................................................................... 38
パートコントロール状態 ............................................................ 30
パフォーマンス .......................................................................... 22
パフォーマンスエディット ......................................................... 37
パフォーマンスエディット画面 .................................................. 37
パフォーマンスコントロール状態 ............................................... 30
パフォーマンスプレイ ............................................................... 26
パフォーマンスプレイ画面 ......................................................... 20
パンチイン/アウト録音 .............................................................. 46

ヒ
ピッチベンドホイール ................................................................10

フ
フォーマット .............................................................................61
フラグ .......................................................................................23
プリセットバンク .......................................................................22

ヘ
ヘッドフォン .............................................................................18

マ
マイク .......................................................................................50
マスターチューン .......................................................................52
マスターボリューム ...................................................................19
マルチパートパフォーマンス ......................................................22

ミ
ミキシング .................................................................................33
ミュート機能 .............................................................................27

メ
メッセージリスト .......................................................................63

モ
モーションシーケンサー .............................................................28
モジュレーションホイール .........................................................10
モジュレーター ..........................................................................38

ユ
ユーザーバンク ..........................................................................22

ラ
ライブセット ....................................................................... 23, 35
ライブセット(Live Set)画面 ......................................................20
ライブラリーバンク ...................................................................22

リ
リアルタイム録音 .......................................................................45
リズムパート .............................................................................43
リズムパターン ..........................................................................43
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レ
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ロ
ローカルコントロール ................................................................53
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ユーザーサポートサービスの
ご案内

■ ユーザー登録のお願い
弊社では、ユーザーの方々をサポートし、関連情報をご提供
するために、本製品をご購入いただいたお客様にユーザー登
録をお願いしております。
ユーザー登録手続きは、下記ウェブサイトよりお願いしま
す。

■ 質問の受付
ヤマハデジタル製品は、常に新技術/高機能を搭載し技術革
新を進める一方、お使いになる方々の負担とわずらわしさを
軽減できるような製品づくりを進めております。また取扱説
明書の記載内容も、よりわかりやすく使いやすいものにする
ため、研究/改善いたしております。
しかし、一部高機能デジタル製品では、取扱説明書だけでは
説明しきれないほどのいろいろな知識や経験を必要としてし
まうものがあります。
実際の操作に関して、基本項目は取扱説明書に解説いたして
おりますが、「記載内容が理解できない」、「手順通りに動作
しない」、「記載が見つからない」といったさまざまな問題が
起こる場合があります。
そのようなお客様への一助となるよう、弊社ではシンセサイ
ザー･デジタル楽器ご相談窓口を開設いたしております。
お気軽にご利用いただきますようご案内申し上げます。
お問い合わせの際には、「製品名」をお知らせください。

付属DAWソフトウェアについては、Steinberg社のホーム
ページをご覧ください。Steinberg社のホームページでは、
製品に関するサポート情報や、最新のアップデータのダウン
ロード、FAQなどを下記URLにて公開しております。
http://japan.steinberg.net/

付属DAWソフトウェアの[ヘルプ(Help)]メニューから
Steinberg社のホームページにアクセスできます。(ヘルプ
メニューには、付属DAWソフトウェアのPDFマニュアルや
追加情報なども掲載されています。)

◆ウェブサイトのご案内
・ヤマハ音楽制作機器ウェブサイト
　https://jp.yamaha.com/mp/

・ヤマハ ダウンロード 
・ヤマハ よくあるお問い合わせ（Q&A)
　https://jp.yamaha.com/support/

ヤマハ株式会社
〒430-8650  静岡県浜松市中区中沢町10-1

*都合により、住所、電話番号、名称、営業時間などが変更になる場合が
ございますので、あらかじめご了承ください。

◆ GNU GENERAL PUBLIC LICENSE
◆ GNU LESSER GENERAL PUBLIC 
LICENSE

ソースコード配布について
本製品の最終出荷日から3年間は、製品のソースコードのうちGNU 
General Public Licenseに基づいてライセンス供与された部分について
は、ソースコードを配布させていただきます。以下の住所にお問い合わ
せください。

〒430-8650 浜松市中区中沢町10-1
ヤマハ(株) 楽器事業統括部
電子楽器事業推進部　電子楽器マーケティンググループ

ソースコードの配布自体は無償ですが、ソースコードの送料につきまし
てはご負担いただきます。
• 弊社(または弊社認定の関係者)以外の第三者による、この製品のソフ
トウェアに対する変更や追加、削除などによって発生したいかなる損
害に対しても、弊社は一切責任を負いません。

• 弊社により一般に公開されたソースコードの再利用は保証されており
ません。ソースコードに関して弊社は一切責任を負いません。

• また、ソースコードは以下のURLでも配布しております。
https://download.yamaha.com/sourcecodes/synth/

ヤマハ音楽制作機器ウェブサイト
https://jp.yamaha.com/mp/

お客様コミュニケーションセンター 
シンセサイザー･デジタル楽器ご相談窓口

上記番号でつながらない場合は TEL 053-460-1666へ
おかけください。
受付: 月曜日～金曜日 10:00～17:00

(土曜、日曜、祝日およびセンター指定の休日を除く)

https://jp.yamaha.com/support/contacts/
index.html

* 営業日や営業時間を変更させていただく場合がございます。 
  あらかじめご了承ください。

※固定電話は、全国市内通話料金でご利用いただけます。
　通話料金は音声案内で確認できます。

0570-015-808
ナビダイヤル(全国共通番号)

https://jp.yamaha.com/support/contacts/index.html
https://jp.yamaha.com/mp/
http://japan.steinberg.net/
https://jp.yamaha.com/mp/
https://jp.yamaha.com/support/
https://download.yamaha.com/sourcecodes/synth/
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保証とアフターサービス
サービスのご依頼、お問い合わせは、お買い上げ店、または
ヤマハ修理ご相談センターにご連絡ください。

● 保証書
本機には保証書がついています。
保証書は販売店がお渡ししますので、必ず「販売店印・お買
い上げ日」などの記入をお確かめのうえ、大切に保管してく
ださい。

● 保証期間
保証書をご覧ください。

● 保証期間中の修理
保証書記載内容に基づいて修理いたします。詳しくは保証書
をご覧ください。

● 保証期間経過後の修理
修理すれば使用できる場合は、ご希望により有料にて修理さ
せていただきます。
有寿命部品については、使用時間や使用環境などにより劣化
しやすいため、消耗劣化に応じて部品の交換が必要となりま
す。有寿命部品の交換は、お買い上げ店またはヤマハ修理ご
相談センターへご相談ください。

● 補修用性能部品の最低保有期間
製品の機能を維持するために必要な部品の最低保有期間は、
製造打切後8年です。

● 修理のご依頼
まず本書の「困ったときは」をよくお読みのうえ、もう一度
お調べください。
それでも異常があるときは、お買い上げの販売店、またはヤ
マハ修理ご相談センターへ修理をお申し付けください。

● 製品の状態は詳しく
修理をご依頼いただくときは、製品名、モデル名などとあわ
せて、故障の状態をできるだけ詳しくお知らせください。

◆ 修理に関するお問い合わせ
ヤマハ修理ご相談センター

上記番号でつながらない場合は TEL 053-460-4830へ
おかけください。
受付 月曜日～金曜日  10:00～17:00

(土曜、日曜、祝日およびセンター指定の休日を除く)
FAX 東日本（北海道/東北/関東/甲信越/東海）

03-5762-2125
西日本（北陸/近畿/中国/四国/九州/沖縄）
06-6649-9340

◆ 修理品お持込み窓口
受付 月曜日～金曜日  10:00～17:00

（土曜、日曜、祝日およびセンター指定の休日を除く）
* お電話は、ヤマハ修理ご相談センターでお受けします。

東日本サービスセンター
〒143-0006
東京都大田区平和島2丁目1-1 
京浜トラックターミナル内14号棟A-5F
FAX 03-5762-2125

西日本サービスセンター
〒556-0011
大阪市浪速区難波中1丁目13-17
ナンバ辻本ニッセイビル7F
FAX 06-6649-9340

*名称、住所、電話番号、営業時間などは変更になる場合があります。

有寿命部品の例
ボリュームコントロール、スイッチ、ランプ、リレー類、
接続端子、鍵盤機構部品、鍵盤接点、ドラムパッドなど

※固定電話は、全国市内通話料金でご利用いただけます。
　通話料金は音声案内で確認できます。

0570-012-808
ナビダイヤル(全国共通番号)
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